Disclaimer

This document contains Honeywell proprietary information. Information contained herein is to be used solely for the purpose submitted, and no part of this document or its contents shall be reproduced, published, or disclosed to a third party without the express permission of Honeywell International Sàrl.

While this information is presented in good faith and believed to be accurate, Honeywell disclaims the implied warranties of merchantability and fitness for a purpose and makes no express warranties except as may be stated in its written agreement with and for its customer.

In no event is Honeywell liable to anyone for any direct, special, or consequential damages. The information and specifications in this document are subject to change without notice.

Copyright 2015 - Honeywell International Sàrl
Contents

1. About this guide ................................................................................................................................. 5

2. Before you begin .................................................................................................................................. 7
   2.1 Supported migration paths ................................................................................................................ 8
   2.2 Understanding differences from prior releases .................................................................................. 10

3. R120.1 to R240.1 migration .................................................................................................................. 11
   3.1, Migrating from R120.1 to R240.1 checklist ..................................................................................... 12
   3.2, Considerations for migration ............................................................................................................. 14
   3.3, Exporting security key database from R120 server .......................................................................... 15
   3.4, Installing and configuring the WDM ................................................................................................. 16
   3.5, Configuring network properties on the computer ............................................................................. 17
      3.5.1 Configuring Cisco switch port setting .......................................................................................... 17
   3.6, Logging on to OneWireless user interface ....................................................................................... 19
   3.7, Performing migration using the First Time Configuration Wizard .................................................... 20
   3.8, Installing the WDM license .............................................................................................................. 24
   3.9, Loading the Device Description file .................................................................................................. 27
   3.10, Downloading the upgrade files from the WDM ............................................................................. 28
      3.10.1 Contents of mn_120_200.zip file ................................................................................................. 29
   3.11, Verifying the OneWireless patch version ....................................................................................... 32
   3.12, Installing the OneWireless R120 patch ......................................................................................... 33
   3.13, Upgrade firmware to R120 latest ..................................................................................................... 34
      3.13.1 Upgrading Multinode firmware to the latest R120 firmware ....................................................... 34
      3.13.2 Upgrading XRY 6000 and SmartRadar FlexLine firmware to the latest R120 firmware .......... 34
   3.14, Decommissioning R120 field devices .............................................................................................. 35
   3.15, Upgrade the R120 sensor and radio firmware to R240 ................................................................. 36
      3.15.1 Upgrading XRY 6000 field device sensor firmware to R240 firmware ...................................... 36
      3.15.2 Upgrading the XRY 6000 field device radio firmware to R240 radio firmware ....................... 36
   3.16, Upgrading the SmartRadar FlexLine radio firmware to R240 radio firmware ............................ 37
   3.17, Upgrading CAN-1WL FlexConn board of SmartRadar FlexLine .................................................. 38
   3.18, Upgrading Wireless System Gateway (WSG) and Multinode to R240 firmware ......................... 39
      3.18.1 Upgrading the Multinode sensor radio firmware ...................................................................... 39
      3.18.2 Upgrade Multinode mesh firmware .......................................................................................... 39
   3.19, Verifying if the migrated devices have joined the OneWireless R240 network ............................ 43
   3.20, Upgrading the XRY 6000 field device to latest OneWireless R240 sensor firmware .................. 44
   3.21, Configuring external interfaces ..................................................................................................... 45
   3.22, Re-configuring OPC/HART/MODBUS interfaces ......................................................................... 46
   3.23, Configuring redundant WDM ....................................................................................................... 47
   3.24, Downgrading Multinode mesh firmware ...................................................................................... 48

4. R202.1 to R240.1 migration .................................................................................................................. 50

5. R210.1 to R240.1 migration .................................................................................................................. 52
   5.1, Migrating from R210 to R240 checklist ............................................................................................ 53
   5.2, Verifying the WDM firmware revision .............................................................................................. 54
   5.3, Configuring Cisco switch port setting ............................................................................................... 55
   5.4, Upgrading the WDM firmware ........................................................................................................ 56
   5.5, Upgrading the field device firmware ............................................................................................... 58
   5.6, Upgrading the FDAP/access point firmware ................................................................................... 60
   5.7, Upgrading CISCO WLC firmware ................................................................................................... 61
6. R220.1 to R240.1 migration .......................................................................................................................... 62
   6.1. Migrating from R220 to R240 checklist .................................................................................................. 63
   6.2. Verifying the WDM firmware revision ................................................................................................. 64
   6.3. Configuring Cisco switch port setting .................................................................................................. 65
   6.4. Upgrading the WDM firmware .............................................................................................................. 66
   6.5. Upgrading the field device firmware .................................................................................................. 68
   6.6. Upgrading the FDAP/access point firmware ....................................................................................... 70
   6.7. Upgrading CISCO WLC firmware .......................................................................................................... 71

7. R230.1 to R240.1 migration ...................................................................................................................... 72
   7.1. Migrating from R230 to R240 checklist ............................................................................................... 73
   7.2. Verifying the WDM firmware revision ................................................................................................. 74
   7.3. Configuring Cisco switch port setting .................................................................................................. 75
   7.4. Upgrading the WDM firmware .............................................................................................................. 76
   7.5. Upgrading the field device firmware .................................................................................................. 78
   7.6. Upgrading the FDAP/access point firmware ....................................................................................... 80
   7.7. Upgrading CISCO WLC firmware .......................................................................................................... 81

8. Migration of OneWireless Network integrated with Experion system ...................................................... 82
   8.1. Supported migration paths .................................................................................................................... 83
   8.2. Planning for migration .......................................................................................................................... 84
   8.3. Post Migration tasks ............................................................................................................................... 85
      8.3.1. Configuring OneWireless Components using Control Builder .................................................. 85
      8.3.2. Importing control strategies with connections to wireless field devices ....................................... 86
      8.3.3. Loading imported strategies with connections to wireless data .................................................. 88

9. Notices ..................................................................................................................................................... 89
   9.1. Documentation feedback ....................................................................................................................... 90
   9.2. How to report a security vulnerability .................................................................................................. 91
1. About this guide

This guide assists you in understanding, planning, and performing the migration of standalone OneWireless Network, as well as OneWireless Network integrated with Experion system. From OneWireless Release 240 onwards, there is no separate OneWireless Experion Migration guide.

Intended audience

This guide is intended for people who are responsible for planning and performing the migration of OneWireless Network.

How to use this guide

This guide provides guidance on:

- Supported migration paths
- Planning considerations for performing a migration
- Performing the pre-migration tasks
- Migrating to the latest OneWireless release
- Configuring the OneWireless components after migration

Required Honeywell documentation

The following documents and sources contain additional information required for migrating and deploying OneWireless Network. It is recommended to have these documents readily available for reference.

<table>
<thead>
<tr>
<th>Document</th>
<th>Document ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OneWireless Release Notes</td>
<td>OWDOC-X252-en-240A</td>
<td>This document provides information about the new functions and features in OneWireless.</td>
</tr>
<tr>
<td>OneWireless Network Planning and Installation Guide</td>
<td>OWDOC-X253-en-240A</td>
<td>This document provides information about planning, designing, and setting up OneWireless Network using WDM, FDAPs, and field devices.</td>
</tr>
<tr>
<td>OneWireless Wireless LAN Controller Configuration Guide</td>
<td>OWDOC-X255-en-240A</td>
<td>This document provides information about planning, designing, setting up, and configuring a OneWireless Network using WDM, FDAPs, Cisco 1552S APs, and field devices.</td>
</tr>
</tbody>
</table>
### About this Guide

<table>
<thead>
<tr>
<th>Document</th>
<th>Document ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OneWireless Parameter Reference Dictionary</strong></td>
<td>OWDOC-X260-en-240A</td>
<td>This document provides information about the parameters associated with the OneWireless devices.</td>
</tr>
<tr>
<td><strong>Experion scenario specific migration guides</strong></td>
<td></td>
<td>Each document describes a single supported migration scenario. These documents are available in the Experion PDF Collection CD.</td>
</tr>
<tr>
<td><strong>Experion Migration Planning Guide</strong></td>
<td>EPDOC-XX70-en-410A</td>
<td>This document assists you in understanding and planning the migration of your Experion system.</td>
</tr>
<tr>
<td><strong>Experion Control Building User’s Guide</strong></td>
<td>EPDOC-XX19-en-410A</td>
<td>This document provides information about performing the tasks using the Control Builder application.</td>
</tr>
</tbody>
</table>

2. Before you begin

Related topics
Supported migration paths on page 8
Understanding differences from prior releases on page 10
2.1 Supported migration paths

The following figure illustrates the valid migration paths supported for OneWireless R240. It also identifies the base release (minimum software release level) at which a node must be, to start the migration.

The qualified migration paths which are supported for OneWireless R240 are as follows. Ensure that you perform the migration in the sequence specified in the table.

<table>
<thead>
<tr>
<th>Current Release</th>
<th>Migration path to be followed</th>
</tr>
</thead>
<tbody>
<tr>
<td>OneWireless R100.1</td>
<td>OneWireless R100.1 &gt; OneWireless R110.1 &gt; OneWireless R120.1 Patch 7 &gt; OneWireless R120.1 Patch 11 &gt; OneWireless R120.1 Patch 12 &gt; OneWireless R240.1</td>
</tr>
<tr>
<td>OneWireless R110.1</td>
<td>OneWireless R110.1 &gt; OneWireless R120.1 Patch 7 &gt; OneWireless R120.1 Patch 11 &gt; OneWireless R120.1 Patch 12 &gt; OneWireless R240.1</td>
</tr>
<tr>
<td>OneWireless R120.1 Patch 4/Patch 5/ Patch 6</td>
<td>OneWireless R120.1 Patch 4/Patch 5/Patch 6 &gt; OneWireless R120.1 Patch 7 &gt; OneWireless R120.1 Patch 11 &gt; OneWireless R120.1 Patch 12 &gt; OneWireless R240.1</td>
</tr>
<tr>
<td>OneWireless R120.1 Patch 7/Patch 8/ Patch 9/Patch 10</td>
<td>OneWireless R120.1 Patch 7/Patch 8/Patch 9/Patch 10 &gt; OneWireless R120.1 Patch 11 &gt; OneWireless R120.1 Patch 12 &gt; OneWireless R240.1</td>
</tr>
<tr>
<td>OneWireless R120.1 Patch 11/ Patch 12</td>
<td>OneWireless R120.1 Patch 11 &gt; OneWireless R120.1 Patch 12 &gt; OneWireless R240.1</td>
</tr>
</tbody>
</table>
Qualified firmware upgrade paths

- **WDM**: The Wireless Device Manager can only be upgraded from OneWireless R210.1 to OneWireless R240.1. The upgrade from R200/R201/R202 to R240 is not supported.

- **Access Points (FDAP, Cisco 1552S) and XYR6000 Field Devices**: OneWireless R240.1 supports firmware upgrade from any previous release, including OneWireless R200.1, R201.1, R202.1, and R210.1. For example, you can directly upgrade an FDAP running R202.1 firmware to R240.1 firmware (without installing R220.1 intermediate firmware).

OneWireless 240.1 Field Product sensor firmware compatibility

<table>
<thead>
<tr>
<th>Sensor Type</th>
<th>Sensor Build Version Released to Market</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temp</td>
<td>277</td>
</tr>
<tr>
<td>HLAI</td>
<td>277</td>
</tr>
<tr>
<td>UIOD</td>
<td>277</td>
</tr>
<tr>
<td>UID</td>
<td>277</td>
</tr>
<tr>
<td>Pressure</td>
<td>277</td>
</tr>
<tr>
<td>Corrosion</td>
<td>252</td>
</tr>
<tr>
<td>OWA</td>
<td>277</td>
</tr>
</tbody>
</table>

Before upgrading to OneWireless R240.1, make sure that you obtain a valid WDM license key. You can obtain the license key as a part of OneWireless ordering process. Also, it is not possible to downgrade the WDM firmware.

<table>
<thead>
<tr>
<th>Current Release</th>
<th>Migration path to be followed</th>
</tr>
</thead>
<tbody>
<tr>
<td>OneWireless R200.1</td>
<td>OneWireless R200.1 &gt; OneWireless R201.1 &gt; OneWireless R202.1 &gt; OneWireless R210.1 &gt; OneWireless R240.1</td>
</tr>
<tr>
<td>OneWireless R201.1</td>
<td>OneWireless R201.1 &gt; OneWireless R202.1 &gt; OneWireless R210.1 &gt; OneWireless R240.1</td>
</tr>
<tr>
<td>OneWireless R202.1</td>
<td>OneWireless R202.1 &gt; OneWireless R210.1 &gt; OneWireless R240.1</td>
</tr>
<tr>
<td>OneWireless R210.1</td>
<td>OneWireless R210.1 &gt; OneWireless R240.1</td>
</tr>
<tr>
<td>OneWireless R220.1</td>
<td>OneWireless R220.1 &gt; OneWireless R240.1</td>
</tr>
<tr>
<td>OneWireless R220.2</td>
<td>OneWireless R220.2 &gt; OneWireless R240.1</td>
</tr>
<tr>
<td>OneWireless R230.1</td>
<td>OneWireless R230.1 &gt; OneWireless R240.1</td>
</tr>
</tbody>
</table>
## 2.2 Understanding differences from prior releases

Migration from OneWireless R120 or releases earlier than R120 to the R240 release requires a hardware change as well as a software upgrade. The following table lists the major differences from OneWireless R120 or earlier releases and the tasks involved to complement these differences.

<table>
<thead>
<tr>
<th>Differences from OneWireless R120 (or earlier) releases</th>
<th>Tasks to be performed</th>
</tr>
</thead>
<tbody>
<tr>
<td>The current OneWireless Network is compliant with the ISA100 Wireless standard and offers interoperability with Honeywell XYR 6000, Honeywell Enraf SmartRadar FlexLine systems, and other third-party field devices. The proprietary wireless protocol used with has been removed from the system and is no longer supported.</td>
<td>Upgrade the firmware of the existing devices to the ISA100 Wireless compatible firmware.</td>
</tr>
<tr>
<td>In the current release of OneWireless Network, you can enable a Multinode to function as an Field Device Access Point (FDAP), which is an access point that communicates using ISA100 Wireless protocol. To achieve this functionality, the firmware image loaded to the Multinode must be of FDAP.</td>
<td>Upgrade the Multinode field device radio with the latest FDAP software image.</td>
</tr>
<tr>
<td>The current OneWireless Network infrastructure includes the Wireless Device Manager (WDM), the central management unit of the OneWireless Network. The WDM is responsible for network security, network resource allocation, data caching, and external interface functionality (including CDA protocol).</td>
<td>Install and configure a WDM.</td>
</tr>
<tr>
<td>The authentication device software that runs on the handheld Personal Digital Assistant (PDA) is replaced with the Provisioning Device Application.</td>
<td>Install the R240 Provisioning Device Application on the provisioning device handheld.</td>
</tr>
<tr>
<td>Ability to configure a Multinode as Wireless System Gateway (WSG) is no longer supported.</td>
<td>Repurpose Multinode that is used as WSG, to function as a regular Multinode.</td>
</tr>
<tr>
<td>New Multinode mesh software enables proper communication with FDAP.</td>
<td>Upgrade Multinode mesh software with the latest release version.</td>
</tr>
<tr>
<td>In the current release, Enraf SmartRadar FlexLine gauge provides support for 17 transducer blocks (upto 8 separate blocks can be used at the same time). In addition, protocol tunneling support is also not available with this release.</td>
<td>Upgrade the Enraf SmartRadar FlexLine gauge radio firmware and the CAN-IWL FlexConn board firmware.</td>
</tr>
</tbody>
</table>
3. R120.1 to R240.1 migration

Related topics
Migrating from R120.1 to R240.1 checklist on page 12
Considerations for migration on page 14
Exporting security key database from R120 server on page 15
Installing and configuring the WDM on page 16
Configuring network properties on the computer on page 17
Logging on to OneWireless user interface on page 19
Performing migration using the First Time Configuration Wizard on page 20
Installing the WDM license on page 24
Loading the Device Description file on page 27
Downloading the upgrade files from the WDM on page 28
Verifying the OneWireless patch version on page 32
Installing the OneWireless R120 patch on page 33
Upgrade firmware to R120 latest on page 34
Decommissioning R120 field devices on page 35
Upgrade the R120 sensor and radio firmware to R240 on page 36
Upgrading the SmartRadar FlexLine radio firmware to R240 radio firmware on page 37
Upgrading CAN-1WL FlexConn board of SmartRadar FlexLine on page 38
Upgrading Wireless System Gateway (WSG) and Multinode to R240 firmware on page 39
Verifying if the migrated devices have joined the OneWireless R240 network on page 43
Upgrading the XYR 6000 field device to latest OneWireless R240 sensor firmware on page 44
Configuring external interfaces on page 45
Re-configuring OPC/HART/MODBUS interfaces on page 46
Configuring redundant WDM on page 47
3.1. Migrating from R120.1 to R240.1 checklist

This topic provides a checklist that describes the significant tasks to be performed for migrating from OneWireless R120 to the target release. The checklist also serves as a ready reference to review the progress of migration as you move from one phase of your migration to another. The sections following the checklist provide the details about each task in detail.

Ensure that the OneWireless Server is installed with OneWireless R120.1 (base release). This document describes only the tasks that you need to perform for migrating from OneWireless R120.1 to R240.1. If your system is installed with any of the releases prior to R120.1, you must migrate to R120.1 and then use this document to migrate to R240.1. To migrate from any releases earlier than R120.1, refer to the migration documentation specific to that release.

⚠️ Attention
- Ensure that you perform the migration tasks in the sequence in which the tasks are listed in the checklist. If you do not perform the tasks in the same sequence, then it may lead to undesired result or damage the device.

<table>
<thead>
<tr>
<th>Task</th>
<th>Go to</th>
<th>Done?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Review and address the migration considerations.</td>
<td>Considerations for migration on page 14</td>
</tr>
<tr>
<td>Step 2</td>
<td>Export the security key database.</td>
<td>Exporting security key database from R120 server on page 15</td>
</tr>
<tr>
<td>Step 3</td>
<td>Install and configure the WDM.</td>
<td>Installing and configuring the WDM on page 16</td>
</tr>
<tr>
<td>Step 4</td>
<td>Install the WDM License</td>
<td>Installing the WDM license on page 24</td>
</tr>
<tr>
<td>Step 5</td>
<td>Configure network properties on the computer that will be used for accessing the OneWireless user interface.</td>
<td>Configuring network properties on the computer on page 17</td>
</tr>
<tr>
<td>Step 6</td>
<td>Log on to the OneWireless user interface.</td>
<td>Logging on to OneWireless user interface on page 19</td>
</tr>
<tr>
<td>Step 7</td>
<td>Perform migration using the First Time Configuration Wizard.</td>
<td>Performing migration using the First Time Configuration Wizard on page</td>
</tr>
<tr>
<td>Step 8</td>
<td>Reload the DD files for the field devices.</td>
<td>Loading the Device Description file on page 27</td>
</tr>
<tr>
<td>Step 9</td>
<td>Download and save the upgrade files from the WDM.</td>
<td>Downloading the upgrade files from the WDM on page 28</td>
</tr>
<tr>
<td>Step 10</td>
<td>Verify the patch version installed on the OneWireless server.</td>
<td>Verifying the OneWireless patch version on page 32</td>
</tr>
<tr>
<td>Step 11</td>
<td>Install the latest available OneWireless R120 patch.</td>
<td>Installing the OneWireless R120 patch on page 33</td>
</tr>
<tr>
<td>Step 12</td>
<td>Upgrade the following firmware to R120 latest. Multinode firmware XYR 6000 field device sensor firmware and the radio firmware SmartRadar FlexLine gauge radio firmware and CAN-IWL FlexConn board firmware</td>
<td>Upgrade firmware to R120 latest on page 34</td>
</tr>
<tr>
<td>Task</td>
<td>Go to</td>
<td>Done?</td>
</tr>
<tr>
<td>---------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Step 13</strong> Decommission the R120 field devices.</td>
<td>Decommissioning R120 field devices on page 35</td>
<td></td>
</tr>
<tr>
<td><strong>Step 14</strong> Upgrade the following R120 sensor or radio firmware to R240 firmware.</td>
<td>Upgrade the R120 sensor and radio firmware to R240 on page 36</td>
<td></td>
</tr>
<tr>
<td>XYR 6000 field device sensor firmware to R150 transition firmware.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XYR 6000 field device sensor firmware to R200 base firmware.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XYR 6000 field device radio firmware to R240 radio firmware.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Step 15</strong> Upgrade the SmartRadar FlexLine gauge radio firmware to R240 radio firmware.</td>
<td>Upgrading the SmartRadar FlexLine radio firmware to R240 radio firmware on page 37</td>
<td></td>
</tr>
<tr>
<td><strong>Step 16</strong> Upgrade the CAN-1WL FlexConn board of SmartRadar FlexLine gauge.</td>
<td>Upgrading CAN-1WL FlexConn board of SmartRadar FlexLine on page 38</td>
<td></td>
</tr>
<tr>
<td><strong>Step 17</strong> Upgrade Wireless System Gateway (WSG) and Multinodes to the R240 firmware.</td>
<td>Upgrading Wireless System Gateway (WSG) and Multinode to R240</td>
<td></td>
</tr>
<tr>
<td><strong>Step 18</strong> Verify if the migrated devices have joined the R240 network.</td>
<td>Verifying if the migrated devices have joined the OneWireless R240 network on page 43</td>
<td></td>
</tr>
<tr>
<td><strong>Step 19</strong> Upgrade field device sensor firmware to the latest R240 firmware.</td>
<td>Upgrading the XYR 6000 field device to latest OneWireless R240 sensor firmware on page 44</td>
<td></td>
</tr>
<tr>
<td><strong>Step 20</strong> Reconfigure the external interfaces.</td>
<td>Configuring external interfaces on page 45</td>
<td></td>
</tr>
<tr>
<td><strong>Step 21</strong> Re-enable the OPC/HART interfaces.</td>
<td>Re-configuring OPC/HART/MODBUS interfaces on</td>
<td></td>
</tr>
<tr>
<td><strong>Step 22</strong> Upgrade the Provisioning Device Application on the Provisioning Device handheld.</td>
<td>See the “Configuring a Provisioning Device handheld” section in the WDM User’s Guide.</td>
<td></td>
</tr>
</tbody>
</table>
3.2. Considerations for migration

Review and address the following considerations before starting the migration.

**OneWireless R120 network configured with Network ID 1**

If your OneWireless R120 system is configured with Network ID 1, to migrate to R240 you must re-provision all the devices in the network. The valid Network ID range in the OneWireless R240 is between 2 and 65535.

When migrating from OneWireless R120 with a Network ID 1, all the devices must be re-provisioned before the migration. The following steps are optional and must be performed only when you face such scenario.

- If the device sensor firmware and the radio firmware are already migrated from R120 to R240, then perform the following:
  1. Configure the R240 system using the First time Configuration Wizard as a new system.
  2. Reset the system to defaults.
  3. Provision all the devices in the ISA100 Wireless network using over-the-air provisioning method. For further information about over-the-air provisioning method, refer to the latest *Wireless Device Manager User's Guide*.
- If the device sensor firmware and the radio firmware are still loaded with R120 versions, initialize the Key Server database using Database Manager (dbman), select a network ID between 2 and 65535, and then provision all the devices in the network before starting the migration. For more information refer to the R120 set of documents.

**Publish period in OneWireless R120 devices**

The configured publish period in R120 devices cannot be migrated to R240. In R240, the publish period is determined by the WDM. When the migrated devices first join the network, the WDM initializes the publish period as 60 seconds for XYR 6000 device and 10 seconds for SmartRadar FlexLine device. The publish period can then be configured as required.

- **Attention**
  For Honeywell Enraf R120 SmartRadar FlexLine gauge, it is recommended to configure the publish period only as ten seconds.

**Replace batteries prior to upgrades**

The batteries of the field devices should be replaced prior to any upgrades.

**Cisco switch port configuration setting**

In case you plan to set up a redundant WDM, ensure that switch port setting are configured for Cisco ports where FDN and PCN ports of WDM are connected. For more information, refer to “Configuring Cisco switch port setting” on page 17.

- **Attention**
  Ensure to disable Gateway redundancy. In addition, you must also disable Sync if Gateway redundancy is configured.
3.3. Exporting security key database from R120 server

You must export the wireless security key database from the R120 Key Server Manager on the OneWireless server. The WDM imports the file from any location on the server during WDM migration.

To export the security key database

1. Click Start > Run.
2. Type KeyServerExportTool.exe, and then press Enter.
   The Export Key Server Data dialog box is displayed.
3. Connect the USB drive to the computer.
4. On the Export Key Server Data dialog box, click Browse, and then select a location on the USB drive.
5. Click Export.
   A message appears indicating that the data is exported to the USB drive.
6. Click OK to acknowledge the message and close the dialog box.
7. After you export the security key database, open the USB drive and verify the contents of the USB drive.
3.4. Installing and configuring the WDM

This section describes the high level tasks you must perform to install and configure the WDM.

- Mount the WDM on to a desired location.

  For more information about mounting a WDM, refer to the section “Installing the WDM” in the WDM User’s Guide.

- Connect an Ethernet cable from the FDN port of the WDM to the OneWireless switch where the OneWireless R120 server is connected.

The following figures illustrate the typical OneWireless network before and after migration.

Figure 1: OneWireless topology before migration

Figure 2: OneWireless topology after migration

Attention

Ensure that the WDM is protected from unauthorized physical access. Unauthorized physical access to WDM or its port (USB/Ethernet/COM/VGA) may result in information disclosure or damage to the WDM.
3.5. Configuring network properties on the computer

Before migrating, you must configure the network properties on your computer to use a different IP subnet. For assessing WDM, the PC\Laptop should be in the same WDM subnet mask. Use a PC\Laptop IP address different from WDM PCN IP(192.168.1.1) address.

Prerequisites

- A desktop or a laptop computer for accessing the OneWireless user interface.

Attention

The steps in the following procedure are specific to Microsoft Windows 7 operating system.

To configure network properties on the computer

1. Click Start, and then click Control Panel. In Control Panel, click Network and sharing center (View Network Status and tasks), and then click Change adapter settings.
2. Right-click the network port connected to the WDM and click Properties.
3. On the General tab, select Internet Protocol (TCP/IP) check box, and then click Properties.

Attention

Note down the current settings in Internet Protocol (TCP/IP) Properties so that, if necessary, you can return to their original values.

4. Configure the IP address and the Subnet mask as 192.168.1.xx and 255.255.255.0 respectively.

Attention

Do not configure the computer with the default IP address of the WDM, 192.168.1.1.

5. Click OK to close the Internet Protocol (TCP/IP) Properties dialog box.
6. On the General tab, click Configure.
7. Click the Advanced tab and then in the Property list, click Speed & Duplex.
8. In the Value list, click Auto and then click OK.
9. Click OK and close all the open dialog boxes.

CAUTION

You must turn on a single WDM at a time, at the default address because the second WDM removes itself from the network if its duplicate address is detected. The removed WDM does not recover unless power-cycled.

3.5.1 Configuring Cisco switch port setting

In case you plan to set up a redundant WDM, ensure the following:

1. CISCO switch port, where the WDM is connected, is configured to operate in access mode.
2. Spanning-tree portfast feature is enabled.
3. Speed is set to auto.
4. Port is in full duplex mode.

Replace the sample CISCO switch configuration for WDM port with the following sample port configuration.

- interface FastEthernet 0/1
- description WDM port
- switchport access vlan 2
- switchport mode access
- spanning-tree portfast
- speed auto
- duplex full
3.6. Logging on to OneWireless user interface

Prerequisites

- One of the following recommended Web browsers must be installed on the computer.
  - Microsoft Internet Explorer 7.0 or higher
  - Firefox 3.6 or higher
  - Google Chrome 12.0 or higher
- Honeywell recommends a browser resolution of 1280 X 1024. Any resolution is supported but it may be necessary to navigate scrollbars or adjust zoom levels to view the entire interface.
- Microsoft Silverlight 5 plug-in is required on the computer used for accessing the user interface. If the computer has a prior version or it is not installed, then you are prompted to install or update the software when you attempt to connect to the WDM. Honeywell is an authorized distributor of the Silverlight software and a copy is maintained on the WDM for installs and upgrades; no internet or external connection is required.

Attention

- Silverlight is backwards compatible. You can still run prior applications based on earlier versions of Silverlight. To save some initialization time during the first use on a new computer and if the computer has internet access, you can pre-install the Silverlight 5 runtime environment at any time using the following link: http://www.microsoft.com/getsilverlight/Get-Started/Install/Default.aspx.

If you are using Internet Explorer, on the Tools menu, click Internet Options, click the Advanced tab, click to clear the check mark from the Do not save encrypted pages to disk check box in the Security area, and then click OK. (This is the default Internet Explorer setting.)

Perform the following steps to log on to the OneWireless user interface.

To log on to OneWireless user interface

1. Open the Web browser and type the URL for the WDM in the address bar.
   - If you are logging on to the user interface for the first time from the PCN side of the network, use the default address, https://192.168.1.1 for logging on to the user interface. If you have connected to FDN side of the network, you must use the ip address 192.168.0.1.
2. If a security warning appears, confirm or allow the security exception.
3. In the User ID and Password fields, type the user name and password, and then click Login.

Attention

- The default User ID and Password configured for the WDM are as follows:
  - User ID: administrator
  - Password: password
- Note that the Password is case-sensitive.
3.7. Performing migration using the First Time Configuration Wizard

Prerequisites

- Ensure that you have the required security key information that you have exported from the R120 Key Server. For exporting the R120 Key Server, refer to the section “Exporting security key database from R120 server” on page 15.

To migrate from OneWireless R120

1. Log on to the OneWireless user interface using the default user name and password. The First Time Configuration Wizard appears.
3. Click Migrate From OneWireless R120 and click Next.

The Migrate from OneWireless R120 page appears.

4. Under Select File From Location, click Browse and navigate to the location where the XML file containing the security key is saved as documented in the section “Exporting security key database from R120 server” on page 15.
5 Select the XML file and click **Open**, and then click **Migrate**.
The security keys are imported into the WDM’s Security Manager and a security configuration migrated message appears.

6 Click **Next**.
The **Wireless Device Manager Settings** page appears.

7 Under **Wireless Device Manager Identification**, type the **Tag Name** and **Description**.
The **Tag Name** is the unique name that is used to identify the WDM. It can be up to 16 characters long and must start with an alphabetic character. Do not use special characters in the Tag Name; underscore is the only acceptable character. After completing the initial configuration, you cannot change the WDM name.

The **Description** can be up to 255 characters long.

8 If you are configuring redundancy, under **Redundancy Configuration**, configure the following:
   a Select **Enable redundancy for this Wireless Device Manager** check box.
   b Click the **Redundancy Role**, as required.
   c In the **Partner IP Address** box, type the PCN IP address of the partner WDM.

9 Click **Next**.
The **Location Settings** page appears.
10 Under Location, set the Country Code to United States (840).

The Country code is used to present any location-specific settings within the OneWireless Network. This feature will be available in the future releases. For example, radio frequency options are location dependent and vary depending on the country code setting. After completing the first time configuration, you cannot modify the Country Code.

11 Under ISA100 Network ID, the Network ID appears by default. This information is imported from the security file that you have exported from the R120 Key Server.

12 Click Next.

The Network Settings page appears.

13 Under Field Device Network (FDN), enter the following information to configure the network settings for wireless field device network. The FDN connects the WDM with one or more FDAPs.

- **Field Device Network IP Address**: Field Device Network IP address (198.168.0.1) is imported from security file and is ready only.

  - **Attention**
    - The IP address must be unique on the network, even if a redundant WDM pair is being configured.
    - After completing the initial configuration, you cannot change the Field Device Network IP Address specified in the First Time Configuration Wizard.

- **Subnet Mask**

- **Assign Addresses to Field Device Access Points (Enable DHCP Server)**: Select this check box to enable the WDM to act as the DHCP Server. Ensure you do not select the check box if the network has another DHCP Server. It is recommended to enable the WDM to act as the DHCP Server.

- **Field Device Access Point IP Address**: This option is enabled only if you have selected the Enable DHCP Server check box. Accept the default range or enter the IP address range according to the network settings in the plant network. The WDM that acts as the DHCP Server assigns IP addresses based on the range specified.

If you do not enable DHCP Server during the first time configuration, it is possible to enable this at a later stage using the Property Panel.

  - **Attention**
    - Ensure that you do not have multiple DHCP servers configured on the FDN. If there is more than one DHCP server connected on the FDN, incorrect IP addresses may be assigned to the Field Device Access Points (FDAPs) which would break communication with the WDM and with field devices.
    - Ensure that no other DHCP clients other than intended FDAPs are connected on the FDN. The presence of unauthorized DHCP clients on the FDN may exhaust the IP address pool in the WDM, and as a result, FDAPs may not get an IP address to communicate with the WDM and field devices.

14 Under Process Control Network (PCN), configure the process control network settings as follows.

- **Process Control Network IP Address**: The process control network settings are used to configure the process control network Ethernet connections for the WDM. This is used for communication with monitoring applications and external controllers.

  - **Attention**
    - The IP address must be unique on the network, even if redundant WDM pair is being configured.

- **Subnet Mask**

- **Default gateway**: Used to access the subnets outside the PCN subnet. This is an optional configuration option.

15 Click Next.

The Network Time page appears.

16 Click Use NTP Server or Use System Time, as required.

You can use either the NTP server or system time to configure the network time of the OneWireless Network.
Attention

- By default, the network time is configured as the system time.
- Consider the following while configuring an external NTP server.
  - NTP server should be on the PCN or FDN.
  - NTP server IP address must be within FDN or PCN subnet unless a default gateway has been configured on the PCN subnet and the NTP server is accessible through the default gateway.
  - NTP server IP address should not overlap with the FDN and PCN IP addresses.
  - NTP server IP address should not overlap with FDAP IP address range, if DHCP Server is enabled.

17 If you are selecting NTPServer, enter the **NTP Server IP Address** and click **Next**.

The **Administrator Information** page appears.

18 Type the new Administrator password in the **New Password** and **Confirm Password** fields, and then click **Next**.

The password must contain at least one character and can contain up to 32 characters. It should not start or end with a space and must not contain single quote (‘).

The Administrator Information page provides an option to modify the username of the default account (administrator). It can only be modified from the FTCW (like country code and subnet id).

The **Configuration Summary** page appears which contains the summary of all the configuration information specified in the **First Time Configuration Wizard**. An incorrect entry is indicated by a warning icon. Hovering the mouse over the icon displays a tooltip with the information about the incorrect entry.

19 Verify the WDM settings, correct errors if any, and then click **Finish**.

If there are any errors in the configuration information that you have provided, then the system does not allow you to click **Finish**.

20 On the **Browser Redirect** dialog box, click **OK**.

The wizard redirects the Web browser to the revised process control network IP address.

Attention

- If you are configuring the WDM to use the same process control network IP address, then the wizard redirects the Web browser.
- If you have configured the WDM using a different PCN IP subnet than the computer, then you need to reconfigure the network settings of the computer to access the user interface using the IP address on the new subnet.
3.8. Installing the WDM license

Prerequisites
- Ensure that you have logged on to the OneWireless user interface.
- Ensure that you have a valid WDM license key. You can obtain the license key as a part of OneWireless ordering process.

To install a WDM license
1. On the ribbon bar, in the System group, click Licensing. The Manage License dialog box appears.

2. Type a System Number and an Authorization Number that you obtained from Honeywell
3 Click Validate.

Based on the features enabled in the license, the Manage License dialog box shows the difference in Status/Value.

If your System Number and Authorization Number are valid, then the Activate button appears in place of the Validate button.
Attention

An error is displayed if the **System Number** and the **Authorization Number** cannot be validated. To correct the error, enter a valid license key and try again.

4 Click **Activate**.

The WDM license activates and displays the feature status / value as **Enabled**. You can click **Change** to modify and use a different license key.
3.9. Loading the Device Description file

A Device Description (DD) file is usually a zip file that can be downloaded from the http://www.honeywellprocess.com/ website. It contains information about the device type, commands that are supported by the device, and other device-specific data. A DD file for a particular field device is used to describe the device and to interpret messages and the device status.

Attention
- DD files loaded prior to migrating the WDM to R230 are discarded to resolve the R120 or R2xx to R240 migration anomaly. Note that this is a onetime behavior that is not repeated after migration to future releases.
- To ensure consistency in the channel names, load the DD files before the device joins the network.

To load the Device Description file
1. On the ribbon bar, in the Maintenance group, click Templates. The Upload DD File dialog box appears.
2. Click Load DD File.
3. Browse to the directory location of the DD file.
4. Select the DD file and click Open. The DD file is uploaded to the WDM and an upload success message appears.
5. Click Close to close the Upload DD File dialog box.
6. Repeat steps to load the DD files for all the device types.
To download and save the upgrade files from the WDM

1. On the ribbon bar, in the **System** group, click **Software**.
   The **Support Software** dialog box appears.

2. From the **Select Software** list, select **Onewireless R120 Migration Firmware**.
3. Click **Save To** to save the files to the computer.
   A confirmation message appears.
4. Click **OK**.
   The **Save As** dialog box appears.
5. Browse to a location on the hard drive to save the files.
6. If required, type the **File name**, and then click **Save**.
7. Extract the zip file to the local computer, using the directory structure specified in the zip file.

The following are the different folders that are available after extracting the **mn_120_200.zip**.

- **Multinode-Mesh**: Contains multinode mesh upgrade and downgrade files.
- **Multinode-Sensor-Radio**: Contains R120 to R240 multinode sensor radio firmware file.
- **Sensor**: Contains R120 latest sensor and radio files. In addition, it also contains R120 to R240 sensor and radio firmware files.

**Attention**
You can avoid referring to the XYR 6000 DSSS folder as the firmware file in the XYR 6000 DSSS folder is already available in the Sensor folder.
### 3.10.1 Contents of mn_120_200.zip file

The mn_120_200.zip file contains the following high level folders based on the firmware type:

- Multinode-Mesh
- Multinode-Sensor-Radio
- Sensor

These high level folders are sorted into sub-folders. The sub folders provide all the firmware upgrade files you require for migrating all devices. The following table displays the files available in each sub-folder.

<table>
<thead>
<tr>
<th>Firmware file</th>
<th>Files in Folder levels</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Level 1</td>
</tr>
<tr>
<td>Multinode-Mesh</td>
<td></td>
</tr>
<tr>
<td>WNMS Model</td>
<td>Downgrade</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>WNMX Model</td>
<td>Downgrade</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Multinode-Sensor-Radio</td>
<td>FDAP_multinode_sensor_radio.bin</td>
</tr>
<tr>
<td>Sensor</td>
<td>Corrosion</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Enraf SmartRadar FlexLine</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>01_Honeywell_XYR 6000 HLAI_SENSOR_09_81.wdf</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>02_Honeywell_XYR6000_RADIO_3_329.wdf</td>
</tr>
<tr>
<td></td>
<td>03_Honeywell_XYR 6000 HLAI_SENSOR_09_150.wdf</td>
</tr>
<tr>
<td></td>
<td>04_Honeywell_XYR 6000 HLAI_SENSOR_53_200.wdf</td>
</tr>
<tr>
<td></td>
<td>05_Honeywell_XYR6000_RADIO_3_200.wdf</td>
</tr>
<tr>
<td>Multi AI DI</td>
<td>01_Honeywell_XYR 6000 MULTI AI DI_SENSOR_07_28.wdf</td>
</tr>
<tr>
<td></td>
<td>02_Honeywell_XYR6000_RADIO_3_329.wdf</td>
</tr>
<tr>
<td></td>
<td>03_Honeywell_XYR 6000 MULTI AI DI_SENSOR_07_150.wdf</td>
</tr>
<tr>
<td></td>
<td>04_Honeywell_XYR 6000 CMULTI AI DI_SENSOR_52_200.wdf</td>
</tr>
<tr>
<td></td>
<td>05_Honeywell_XYR6000_RADIO_3_200.wdf</td>
</tr>
<tr>
<td>Multi AI DI DO</td>
<td>01_Honeywell_XYR 6000 MULTI AI DI DO_SENSOR_07_28.wdf</td>
</tr>
<tr>
<td></td>
<td>02_Honeywell_XYR6000_RADIO_3_329.wdf</td>
</tr>
<tr>
<td></td>
<td>03_Honeywell_XYR 6000 MULTI AI DI DO_SENSOR_07_150.wdf</td>
</tr>
<tr>
<td></td>
<td>04_Honeywell_XYR 6000 CMULTI AI DI DOSENSOR_52_200.wdf</td>
</tr>
<tr>
<td></td>
<td>05_Honeywell_XYR6000_RADIO_3_200.wdf</td>
</tr>
<tr>
<td>Multi DI</td>
<td>01_Honeywell_XYR 6000 MULTI DI_SENSOR_06_22.wdf</td>
</tr>
<tr>
<td></td>
<td>02_Honeywell_XYR6000_RADIO_3_329.wdf</td>
</tr>
<tr>
<td></td>
<td>03_Honeywell_XYR 6000 MULTI DI_SENSOR_06_150.wdf</td>
</tr>
<tr>
<td></td>
<td>04_Honeywell_XYR 6000 MULTI DI_SENSOR_53_200.wdf</td>
</tr>
<tr>
<td></td>
<td>05_Honeywell_XYR6000_RADIO_3_200.wdf</td>
</tr>
</tbody>
</table>
The firmware upgrade file “Honeywell_XYR6000_RADIO_3_200.wdf” in XYR 6000 DSSS folder is also available in the Sensor folder.

The firmware files available in the Sensor folder are prefixed with numbers. These numbers indicate the type of firmware files. These files are arranged in the order you need to perform firmware upgrades. Following table defines the type of firmware files for the prefixes.

<table>
<thead>
<tr>
<th>Prefix number</th>
<th>Type of firmware file</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>Latest R120 Sensor firmware file</td>
</tr>
<tr>
<td>02</td>
<td>Latest R120 Radio firmware file</td>
</tr>
<tr>
<td>03</td>
<td>R150 Sensor Transitional firmware file</td>
</tr>
<tr>
<td>04</td>
<td>R200 Sensor Base firmware file</td>
</tr>
<tr>
<td>05</td>
<td>R230 Radio firmware file</td>
</tr>
</tbody>
</table>
3.11. Verifying the OneWireless patch version

Verify the version of the patch installed on your OneWireless server as follows:

- Open Control Panel > Add or Remove Programs.

  The Add or Remove Programs window lists all the OneWireless R120 patches installed on the system.

Verify that OneWireless R120 Patch 12 is installed.
3.12. Installing the OneWireless R120 patch

Before migrating to OneWireless R240, it is mandatory to install the OneWireless R120 Patch 12 on the OneWireless R120 server. It is mandatory to update the server components and the firmware components to the latest patch revision.

You can download the latest OneWireless patch from the Honeywell Process Solutions website (http://www.honeywellprocess.com). For information about installing the patch, refer to the Software Change Notice available with the patch.
3.13. Upgrade firmware to R120 latest

Upgrade the following firmware to R120 latest.
• Multinode firmware
• XYR 6000 field device sensor firmware and the radio firmware
• SmartRadar FlexLine gauge radio firmware and CAN-1WL FlexConn board firmware

3.13.1 Upgrading Multinode firmware to the latest R120 firmware

Multinode sensor radio firmware and mesh firmware must be upgraded to the latest R120 firmware revision before migration.
The R120 multinode sensor radio firmware available is available at the path below: C:\Program Files\Honeywell\OneWireless\System\Firmware\Multinode-Sensor-Radio\RAP120.1-33.12
For R120 mesh firmware is available in the mn_120_200.zip file.
Refer to the section “Downloading the upgrade files from the WDM” on page 28.

For more information about upgrading the Multinode firmware, refer to the section “Upgrading Multinode firmware” in the OneWireless R120 Getting Started with Honeywell OneWireless guide.

3.13.2 Upgrading XYR 6000 and SmartRadar FlexLine firmware to the latest R120 firmware

Upgrade the following firmware to the latest OneWireless R120 firmware revisions.
• XYR 6000 field device sensor firmware and the radio firmware
• SmartRadar FlexLine gauge radio firmware and CAN-1WL FlexConn board firmware

Download the latest firmware files from the WDM. Refer to the section “Downloading the upgrade files from the WDM” on page 28.

After you download and save the upgrade files from the WDM, browse to the Sensor folder. The latest OneWireless R120 sensor firmware and radio firmware are available in all the sub-folders under the Sensor folder. The file with the prefix 01 is the latest R120 Sensor firmware file. The file with the prefix 02 is the latest R120 Radio firmware file.

XYR 6000 field device radio firmware revisions
The minimum radio firmware revision of the field device required for migrating to OneWireless R240 is Revision 3, build 329 (RAP120.1-33.12).

For more information about upgrading the field device firmware, refer to the section “Upgrading wireless transmitter sensor and radio firmware” in the OneWireless R120 Getting Started with Honeywell OneWireless guide.

Honeywell SmartRadar FlexLine — CAN-1WL FlexConn board firmware revision
The minimum firmware revision of the Honeywell Enraf CAN-1WL FlexConn board required for migrating to OneWireless R240 is Revision 10, build 163. For more information about upgrading the FlexConn boards of a SmartRadar FlexLine gauge, refer to the Enraf CAN-Upgrade Manual SmartRadar FlexLine.

The minimum radio firmware revision of the SmartRadar FlexLine field device required for migrating to OneWireless R240 is Revision 3, build 329 (RAP120.1-33.12).

The latest R120 radio firmware is available in all the sub-folders of the Sensor folder and can be identified with the prefix 02.
3.14. Decommissioning R120 field devices

To decommission the field devices

1. Inactivate the field device channels as follows.
   a. In the Monitoring view of Wireless Builder, right-click the field device and choose Inactivate > Select Item(s) Content(s).
      A confirmation dialog box appears.
   b. Click Yes.
      The field device channels appear as inactive (blue icon).

2. In the Monitoring view, select all the devices and click the Delete icon on the toolbar.
   A confirmation dialog box appears.

3. Click Continue.
   The Delete Selected object(s) dialog box appears.

4. Click Delete Selected object(s).
   The selected wireless device blocks and their associated templates are deleted. The deleted devices now appear as uncommissioned devices under the WSG.
3.15. Upgrade the R120 sensor and radio firmware to R240

Upgrade the following R120 sensor and radio firmware to radio firmware to R240 firmware.

- XYR 6000 field device sensor firmware to R150 transition firmware.
- XYR 6000 field device sensor firmware to R200 base firmware.
- XYR 6000 field device radio firmware to R240 radio firmware.

3.15.1 Upgrading XYR 6000 field device sensor firmware to R240 firmware

Using the OneWireless server, upgrade the R120 field device sensor firmware to the R150 transition firmware and then to the R200 base firmware. The transition firmware and base firmware files are special revisions of the sensor firmware files used to migrate the devices to ISA100 Wireless compatible firmware. The latest firmware files can be downloaded from the WDM. Refer to the section “Downloading the upgrade files from the WDM” on page 28 for further information.

The R150 sensor transition firmware and the R200 base firmware files are available in all the sub-folders of the Sensor folder from the extracted mn_120_200.zip file. The file with the prefix 03 is the R150 Sensor Transition firmware, while the prefix 04 is the R200 Sensor base firmware file.

For more information about upgrading the field device sensor firmware, refer to the section “Upgrading wireless transmitter sensor and radio firmware” in the OneWireless R120 Getting Started with Honeywell OneWireless guide.

CAUTION

It is mandatory to upgrade the field device firmware in the following sequence.

- Upgrade the sensor firmware
  - XYR 6000 field device sensor firmware to R150 transition firmware.
  - XYR 6000 field device sensor firmware to R200 base firmware.
- Upgrade the radio firmware

If you are not upgrading according to the above mentioned sequence, the field device stops communicating with the OneWireless R120 system and does not establish communication with the OneWireless R240 network.

Attention

Note that while upgrading the field device sensor firmware, it is mandatory to upgrade the transition firmware first, and then the base firmware.

3.15.2 Upgrading the XYR 6000 field device radio firmware to R240 radio firmware

Using the OneWireless Server, upgrade the XYR 6000 field device radio firmware to the R240 radio firmware. The R240 radio firmware is the ISA100 Wireless compatible firmware.

The field device radio firmware files are available in all the sub-folders of the sensor folder from the extracted mn_120_200.zip file. The file with the prefix 05 is the latest R240 Radio firmware file.

All XYR 6000 devices use the same R240 radio firmware. After completing this step, the field devices migrate to the latest OneWireless release and are no longer accessible from the R120 OneWireless server.
3.16. Upgrading the SmartRadar FlexLine radio firmware to R240 radio firmware

Using the OneWireless server, upgrade the SmartRadar FlexLine radio firmware to the R240 radio firmware. The R240 radio firmware is the ISA100 Wireless compatible firmware.

The field device radio firmware files are available in all the sub-folders of the sensor folder from the extracted mn_120_200.zip file. The file with the prefix 05 is the latest R240 Radio firmware file.

For more information about upgrading the SmartRadar FlexLine gauge radio firmware, refer to the section “Upgrading wireless transmitter sensor and radio firmware” in the OneWireless R120 Getting Started with Honeywell OneWireless guide.
3.17. Upgrading CAN-1WL FlexConn board of SmartRadar FlexLine

You must upgrade the firmware on the CAN-1WL FlexConn board of a SmartRadar FlexLine gauge using the CAN SD card. For more information about upgrading the FlexConn boards of a SmartRadar FlexLine, refer to the Enraf CAN-Upgrade Manual SmartRadar FlexLine.

After completing the firmware upgrade, you must switch off the SmartRadar FlexLine, remove the CAN SD card, and then restart the SmartRadar FlexLine. Only after restarting, the device becomes part of the OneWireless R240 Network.

For more information about migrating a SmartRadar FlexLine, refer to the SmartRadar FlexLine User’s Guide.
3.18. Upgrading Wireless System Gateway (WSG) and Multinode to R240 firmware

Upgrading Wireless System Gateway (WSG) and Multinode to the OneWireless R240 firmware involves the following tasks.

- Upgrading WSG and Multinodes to the OneWireless R240 Multinode sensor radio firmware.
- Upgrading WSG and Multinodes to the OneWireless R240 Multinode mesh firmware.

**CAUTION**

It is mandatory to upgrade the Multinode firmware in the following sequence.

1. Upgrade the multinode sensor radio firmware
2. Upgrade the multinode mesh firmware

Mistakenly if you upgrade the mesh firmware before upgrading the sensor radio firmware, you must downgrade the mesh firmware and then start upgrading the Multinode firmware in the sequence mentioned in this document.

For more information about downgrading the Multinode mesh firmware, refer to the section Downgrading Multinode mesh firmware on page 48.

**Attention**

- In case of WNMM multinode, migration to OneWireless R2xx is not supported.

**Attention**

After migration, the multinodes will join the OneWireless network in unprovisioned state. You must accept the unprovisioned device using the OneWireless user interface. For more information on provisioning devices in the OneWireless network, refer to the Wireless Device Manager User's Guide.

### 3.18.1 Upgrading the Multinode sensor radio firmware

**To upgrade the Multinode sensor radio firmware**

1. Log on to the Multinode Configuration Tool as follows.
   - Open Internet Explorer and type the WAN IP address in the address bar.
   - In the **Username** and **Password** fields, type the user name and password.
   - Select the **I agree to the terms and conditions below** check box, and then click **Sign In**.
     The System Configuration - General page appears.

2. In the left pane, under **System Administration**, click **System Upgrade**.
   The System Administration - System Upgrade page appears. The Firmware Upgrade tab is selected by default.

3. Under **Select sensor radio software here**, click **Browse**.

4. Browse to the directory where the *mn_120_200.zip* file is extracted.

5. In the extracted *mn_120_200.zip* file, browse to the Multinode- Sensor- Radio folder and then select the FDAP_multinode_sensor_radio.bin firmware file.

6. Click **Upload Firmware** to begin the firmware upgrade operation.
   After completing the firmware upgrade operation, the message **System has been upgraded successfully** appears.

7. Click **Back** to return to the Multinode Configuration Tool.

### 3.18.2 Upgrade Multinode mesh firmware

OneWireless Network supports the following two types of Multinode models. This section describes the tasks that you need to perform to upgrade the Multinode mesh firmware of both these models. The Multinode model is printed on the label on the back of the unit.

- WNMS – Extended Temperature Multinode with ISA100 (DSSS) sensor radio.
- WNMX – Standard Temperature Multinode with ISA100 (DSSS) sensor radio.
Attention

In the Multinode Configuration window, select Logs > System Logs. In the System Logs page, blocks = 127 is for WNMS – Extended Temperature Multinode and blocks = 64 is for WNMX – Standard Temperature Multinode.

The upgrade procedure involves loading a series of files to the Multinode. Note that the firmware files must be loaded in the order given, or else unexpected behavior could result, including the malfunctioning of the unit.

<table>
<thead>
<tr>
<th>Mesh firmware revisions</th>
</tr>
</thead>
<tbody>
<tr>
<td>WNMS — 4.3.1.00.102</td>
</tr>
<tr>
<td>WNMX – 4.3.1.8M.00.48</td>
</tr>
</tbody>
</table>

To upgrade the Multinode mesh firmware for WNMS models

1 Log on to the Multinode Configuration Tool as follows.
   1. Open Internet Explorer and type the WAN IP address in the address bar.
   2. In the Username and Password fields, type the user name and password.
   3. Select the I agree to the terms and conditions below check box, and then click Sign In.

   The System Configuration - General page appears.

2 In the left pane, under System Administration, click System Upgrade.

   The System Administration - System Upgrade page appears. The Firmware Upgrade tab is selected by default.

3 Under Select mesh software here, click Browse.

4 Browse to the directory where the mn_120_200.zip file is extracted.

5 In the mn_120_200 folder, navigate to the sub-folder Multinode-Mesh\WNMS Model\Upgrade that contains a list of the following Multinode mesh firmware files.
   • 1_525I_4.3.1.interim-01.33.bin
   • 2_rescueImage1.0.7.no-reboot.bin
   • 3_525A-3_4.4.0.00.76.bin
   • 4_525A-3_4.4.0.00.102.bin
   • 525I_4.3.1.00.33.bin

6 If the Multinode is at build 4.3.1.00.30 or earlier, select 5251_4.3.1.00.33.bin and click Upload Firmware.

   The Multinode reboots after the firmware upgrade operation is complete.

7 Select 1_5251_4.3.1.interim-01.33.bin and click Upload Firmware to begin firmware upgrade.

   The Multinode reboots after the firmware upgrade operation is complete.

8 Select 2_rescueImage1.0.7.no-reboot.bin and click Upload Firmware to begin the firmware upgrade.

   The message, System Upgrade Failed: Did not find transmit log appears. Ignore the message and proceed with the firmware upgrade operation.

9 Select 3_525A-3_4.4.0.00.76.bin and click Upload Firmware to begin firmware upgrade.

   The message, System has been upgraded successfully appears.

10 Click System Administration > Reboot.

   The Multinode reboots and upgrades to 525A-3 build 4.4.0.00.76. The WAN IP address is preserved after the upgrade and is accessible from the WAN 1 port. After the Multinode starts up, use the default user account to access the Multinode Configuration Tool.

   **CAUTION**

   Ensure that you restart the Multinode before performing the next step. Failing to reboot causes the Multinode to restore to default settings.

11 Repeat steps 2 through 4 and select 4_525A-3_4.4.0.00.102.bin and click Upload Firmware to start the firmware upgrade operation.
The message, **System has been upgraded successfully** appears. The Multinode reboots after the firmware upgrade operation is complete.

12 After upgrading the firmware to **4.525A-3.4.4.0.00.102.bin**, the operating mode of the migrated Multinode changes to FIPS mode. Honeywell recommends using only Non-FIPS mode. Configure the operating mode of the Multinode to Non-FIPS as follows:

a. On the Multinode Configuration Tool, under **System Configuration**, click **Operating Mode**.

b. Under **Submode**, clear the **FIPS 140-2 mode** check box.

c. Click **Apply**.

A message appears indicating that the changes are applied and then the Multinode reboots.

**Attention**

Changing the operating mode from FIPS to Non-FIPS restores all the configuration settings to default settings. After you upgrade the multinode mesh firmware for WNMS models, the device will enter factory default state. You will have to re-configure all multinode again. You can access the multinode using the default IP address (192.168.254.254)

13 Configure the **TCP/IP properties** as follows:

- **IP Address**: 192.168.254.1
- **Network Mask**: 255.255.255.0

**Attention**

The computer IP address should not conflict with any other IP address in the network if a switch is connected.

14 To view or change your TCP/IP settings, perform the following steps:

a. If the operating system on your computer is Windows 2000 or XP, choose **Start > Settings > Network and Dialup Connections > Local Area Connection**.

b. Click **Properties**.

The **Local Area Connection Properties** dialog box appears.

c. Select **TCP/IP protocol**, and then click **Properties**.

The **Internet Protocol (TCP/IP) Properties** dialog box appears.

d. Click **Use the following IP address** and then in the **IP Address** and **Subnet mask** boxes, type **192.168.254.1** and **255.255.255.0**, respectively.

e. Click **OK**.

The **Local Area Connection Properties** dialog box closes.

f. Click **OK**.

The **Internet Protocol (TCP/IP) Properties** dialog box closes.

15 Open a browser window and type the following default IP address for the unit’s Local LAN in the address bar: **https://192.168.254.254**.

**Attention**

For some versions of the Mult inode, the WAN2 cable is accessible through the following IP address — **192.168.15.1**.

16 On the Multinode Configuration Tool page, type the default user name **CryptoOfficer** and the password **CryptoFIPS**.

If the system prompts you to change the default password, change the password to proceed.

17 Configure the Web browser settings as follows.

The web browser version should be either of the following – Internet Explorer (IE) version 6 or later or Firefox version 3.6.3 or later.

- In the IE web browser:
  - Click **Tools > Internet Options > Advanced**, and then select the **Transport Layer Security (TLS)**, **TLS 1.0** check box.
  - Click **Tools > Internet Options > Advanced**, and then clear the **Secure Sockets Layer (SSL)**, **SSL 2.1** check box. By default, Use SSL 3.0 check box is selected.
To upgrade the Multinode mesh firmware for WNMX models

1. Log on to the Multinode Configuration Tool as follows.
   1. Open Internet Explorer and type the WAN IP address in the address bar.
   2. In the Username and Password fields, type the user name and password.
   3. Select the I agree to the terms and conditions below check box, and then click Sign In.
      The System Configuration - General page appears.

2. In the left pane, under System Administration, click System Upgrade.
   The System Administration - System Upgrade page appears. The Firmware Upgrade tab is selected by default.

3. Under Select mesh software here, click Browse.

4. Browse to the directory where the mn_120_200.zip file is extracted, and navigate to the subdirectory WNMX Model\Upgrade.

5. In the mn_120_200 folder, navigate to the sub-folder Multinode-Mesh\WNMX Model\Upgrade that contains a single 525I_4.3.1.8M-00.48.bin file.

6. Select 525I_4.3.1.8M-00.48.bin and then click Upload Firmware.
   The message, System has been upgraded successfully appears. The Multinode automatically reboots. After the Multinode starts up, use the default user account to access the Multinode Configuration Tool.

After completing this step, all the field devices and the Multinodes join the ISA100 Wireless field device network and start appearing in the Selection Panel/Map view of the OneWireless user interface. To understand more about the current state of the device icons appearing on the user interface, refer to the WDM User's Guide.

⚠️ Attention
- Note that the devices may take up to one hour to join the network.
3.19. Verifying if the migrated devices have joined the OneWireless R240 network

After upgrading the firmware of all the devices in the OneWireless R120 system, the devices start joining the network. All the migrated devices that have joined the network appear in the Selection Panel of the OneWireless R240 user interface. Verify if all the migrated devices are appearing in the Selection Panel.
3.20. Upgrading the XYR 6000 field device to latest OneWireless R240 sensor firmware

The R200 base firmware installed during migration may not be the released firmware and must be updated. The field device radio firmware is preloaded on the WDM. The latest field device sensor firmware files can be downloaded from Honeywell Process Solutions website.

To upgrade the field device sensor firmware

1. On the Selection Panel of the OneWireless user interface, select the field device.
   You can select multiple devices using the Selection Panel or the map view. Use SHIFT+click to select multiple items in a successive list. Use CTRL+click to select multiple items not in succession.

2. To upgrade the application firmware of the selected field device, on the ribbon bar, in the **Upgrade** group, click **Application**.
   The **Application Firmware Upgrade** dialog box appears.

3. Depending on the firmware type, the available upgrade files appear by default. Select the required file from the list of upgrade files.
   If the file is not available in the list, perform the following steps.
   a. Click **Add** to browse to the directory location of the firmware upgrade file.
   b. Click **Open**.

4. Click **Upgrade**.
   The **Application Firmware Upgrade** dialog box closes.
   The **Firmware Upgrade Status** dialog box displaying the status of the upgrade appears. Closing the dialog box allows the upgrade operation to run in the background. The upgrade status is displayed in the status bar.
   Click the firmware upgrade status box to open the dialog box again. If multiple users are simultaneously upgrading different device firmware, all the users can view the progress of all the device upgrades.
   While upgrading the application firmware of a field device, the LCD display of the field device displays the firmware upgrade status. The status is displayed until the upgrade operation completes or aborts.
   Once the upgrade is complete, the status column displays the status as complete. If firmware upgrade fails for a device, you can abort the upgrade and start again. To abort firmware upgrade for individual devices, click the abort button next to the status indicator.

5. Close the **Firmware Upgrade Status** dialog box.

6. Verify the upgraded version of the field device firmware as follows:
   - On the Selection Panel, select the XYR 6000 field device.
   - On the Property Panel, expand **Device Manager Summary**.
   - Under **Identification**, verify the **Revision**.

For information about upgrading SmartRadar FlexLine application firmware, refer to the *SmartRadar FlexLine User’s Guide*.

**Attention**

To initiate the firmware upgrade of the HCI-1WL (CAN-1WL) board using the Application firmware, the SD card must be inserted in the HCI-1WL (CAN-1WL) board. Also, the SD card should not be write protected.
3.21. Configuring external interfaces

Using the OneWireless user interface, reconfigure the external interfaces. Ensure that you perform the following while reconfiguring the external interfaces.

- Manually configure the Modbus Registers.
- Reconfigure the device/parameter tag names, since the naming convention is different from R120.

For more information about configuring external interfaces, refer to the section “Activate process control interfaces” in the WDM User’s Guide.
3.22. Re-configuring OPC/HART/MODBUS interfaces

After migration, the OPC, HART, or MODBUS interfaces are disabled in the OneWireless user interface. Perform the following steps to enable the disabled interfaces.

To re-configure OPC/HART/MODBUS interfaces
1. On the Selection Panel, expand the WDM icon and select HART/OPC/MODBUS.
2. On the Property Panel, expand Configuration.
3. In the Interface list, click Enabled.
4. Click Apply.
3.23. Configuring redundant WDM

For configuring redundant WDM, refer to the latest *OneWireless Wireless Device Manager User's Guide.*
3.24. Downgrading Multinode mesh firmware

The downgrade procedures are applicable only in a situation in which you have upgraded the mesh firmware before upgrading the sensor radio firmware. This is because it is mandatory to upgrade the sensor radio firmware before upgrading the mesh firmware. This section describes the procedures to downgrade the Multinode mesh firmware for both the Multinode types, if required.

⚠️ Attention
Honeywell does not support downgrade of Multinode firmware from R2xx to R1xx.

Note that after downgrading the mesh firmware, all the configuration information restores to default values.

To downgrade the Multinode mesh firmware for WNMS models

1 Log on to the Multinode Configuration Tool as follows.
   a Open Internet Explorer and type the WAN IP address in the address bar.
   b In the Username and Password fields, type the user name and password.
   c Select the I agree to the terms and conditions below check box, and then click Sign In.
      The System Configuration - General page appears.

2 In the left pane, under System Administration, click System Upgrade.
   The System Administration - System Upgrade page appears. The Firmware Upgrade tab is selected by default.

3 Under Select mesh software here, click Browse.

4 Browse to the directory where the mn_120_200.zip file is extracted.

5 In the mn_120_200 folder, navigate to the sub-folder Multinode-Mesh\WNMS Model\Downgrade that contains the following downgrade files.
   • 1_rescue-image-4.2.0HWL.bin
   • 2_redboot-3.28.no-reboot.bin
   • 3_525I_4.3.1.00.33-downgrade.bin
   • 4_525I_4.3.1.00.48.bin

6 Select 1_rescue-image-4.2.0HWL.bin and click Upload Firmware to begin firmware downgrade.
   The Multinode reboots after the firmware downgrade operation is complete.

7 Select 2_redboot-3.28.no-reboot.bin and click Upload Firmware to begin the firmware downgrade.
   The message, System Upgrade Failed: Did not find transmit log appears. Ignore the message and proceed with the firmware downgrade operation.

8 Select 3_525I_4.3.1.00.33-downgrade.bin and click Upload Firmware to begin firmware downgrade.
   Wait until system reboots and starts running with the firmware, 525I build 4.3.1.00.33. You can then use the default WAN IP address 192.168.254.254 and the default user account to access the Multinode.

9 Repeat steps 2 through 4, select 3_525I_4.3.1.00.48-downgrade.bin and then click Upload Firmware to begin firmware downgrade.
   Wait until system reboots and starts running with the firmware, 525I build 4.3.1.00.48.

To downgrade the Multinode mesh firmware for WNMX models

1 Log on to the Multinode Configuration Tool as follows.
   a Open Internet Explorer and type the WAN IP address in the address bar.
   b In the Username and Password fields, type the user name and password.
   c Select the I agree to the terms and conditions below check box, and then click Sign In.
      The System Configuration - General page appears.

2 In the left pane, under System Administration, click System Upgrade.
   The System Administration - System Upgrade page appears. The Firmware Upgrade tab is selected by default.

3 Under Select mesh software here, click Browse.
4 Browse to the directory where the **mn_120_200.zip** file is extracted.

5 In the **mn_120_200** folder, navigate to the sub-folder **Multinode-Mesh\WNMX Model\Downgrade** that contains the following two downgrade files.
   - 1_5251_4.3.1.00.34.bin
   - 2_5251_4.3.1.00.48.bin

6 Select **5251_4.3.1.00.34.bin** and click **Upload Firmware** to begin firmware downgrade.
   The message **System has been upgraded successfully** appears. The Multinode automatically reboots. After
   the Multinode starts up, use the default user account to access the Multinode Configuration Tool.

7 Select **3_5251_4.3.1.00.48-downgrade.bin** and click **Upload Firmware** to begin firmware downgrade.
   The message **System has been upgraded successfully** appears. The Multinode automatically reboots.
4. **R202.1 to R240.1 migration**

OneWireless R240 provides a new feature where you can download all the firmware files directly from the WDM. In addition, FDAP and other devices can be directly upgraded from R202.1 to R240.1. Only WDM must be upgraded to R210.1 and from R210.1 to R240.1. For releases earlier to 202.1, first migrate all devices to R202.1 and from R202.1 to R240.1. Also, before migrating to R240.1, you must first obtain a valid license key.
5. **R210.1 to R240.1 migration**

**Related topics**
- Migrating from R210 to R240 checklist on page 53
- Verifying the WDM firmware revision on page 54
- Configuring Cisco switch port setting on page 55
- Upgrading the WDM firmware on page 56
- Upgrading the field device firmware on page 58
- Upgrading the FDAP/access point firmware on page 60
- Upgrading CISCO WLC firmware on page 61
## 5.1. Migrating from R210 to R240 checklist

This topic provides a checklist that describes the significant tasks to be performed for migrating from OneWireless R210 to the target release. The checklist also serves as a ready reference to review the progress of migration as you move from one phase of your migration to another. The sections following the checklist provide the details about each task in detail.

This section describes only the tasks that you need to perform for migrating from OneWireless R210.1 to R240.1. If you are migrating from releases prior to R202, you must refer to the migration documentation specific to that release.

<table>
<thead>
<tr>
<th>Task</th>
<th>Go to</th>
<th>Done?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Log on to the OneWireless user interface.</td>
<td>Logging on to OneWireless user interface on page 19</td>
</tr>
<tr>
<td>Step 2</td>
<td>Verify the WDM firmware revision.</td>
<td>Verifying the WDM firmware revision on page 54</td>
</tr>
<tr>
<td>Step 3</td>
<td>Upgrade the WDM firmware.</td>
<td>Upgrading the WDM firmware on page 56</td>
</tr>
<tr>
<td>Step 4</td>
<td>Install the WDM license</td>
<td>Installing the WDM license on page 24</td>
</tr>
<tr>
<td>Step 5</td>
<td>Load the DD files for the field devices.</td>
<td>Loading the Device Description file on page 27</td>
</tr>
<tr>
<td>Step 6</td>
<td>Upgrade the sensor firmware of all field devices.</td>
<td>Upgrading the field device firmware on page 58</td>
</tr>
<tr>
<td>Step 7</td>
<td>Upgrade the radio firmware of all field devices.</td>
<td>Upgrading the field device firmware on page 58</td>
</tr>
<tr>
<td>Step 8</td>
<td>Upgrade the radio firmware of all FDAP routers.</td>
<td>Upgrading the FDAP/access point firmware on page 60</td>
</tr>
<tr>
<td>Step 9</td>
<td>Upgrade the radio firmware of all FDAP access points.</td>
<td>Upgrading the FDAP/access point firmware on page 60</td>
</tr>
<tr>
<td>Step 10</td>
<td>Upgrade the sensor radio firmware of all Multinodes.</td>
<td>Upgrading the FDAP/access point firmware on page 60</td>
</tr>
<tr>
<td>Step 11</td>
<td>Upgrade the CISCO WLC Firmware</td>
<td>Upgrading CISCO WLC firmware on page 61</td>
</tr>
<tr>
<td>Step 12</td>
<td>Re-enable the OPC/HART interfaces.</td>
<td>Re-configuring OPC/HART/MODBUS interfaces on page 46</td>
</tr>
<tr>
<td>Step 13</td>
<td>Upgrade the Provisioning Device Application on the Provisioning Device handheld.</td>
<td>See the “Configuring a Provisioning Device handheld” section in the WDM User's Guide.</td>
</tr>
<tr>
<td>Step 14</td>
<td>Verify if the migrated devices have joined the R240 network.</td>
<td>Verifying if the migrated devices have joined the OneWireless R240 network on page 43</td>
</tr>
</tbody>
</table>
5.2. Verifying the WDM firmware revision

To verify the WDM firmware revision

1. On the Selection Panel of the OneWireless user interface, select the WDM.
2. On the Property Panel, expand Device Manager Summary.
3. Under Identification group, review the firmware version displayed in the Revision field.
5.3. Configuring Cisco switch port setting

In case you plan to set up a redundant WDM, ensure the following:

1. CISCO switch port, where the WDM is connected, is configured to operate in access mode.
2. Spanning-tree portfast feature is enabled.
3. Speed is set to auto.
4. Port is in full duplex mode.

Replace the sample CISCO switch configuration for WDM port with the following sample port configuration.

- interface FastEthernet 0/1
- description WDM port
- switchport access vlan 2
- switchport mode access
- spanning-tree portfast
- speed auto
- duplex full
5.4. Upgrading the WDM firmware

Download the latest WDM firmware file from the Honeywell Process Solutions website.

Before upgrading to OneWireless R240.1, make sure that you obtain a valid WDM license key. You can obtain the license key as a part of OneWireless ordering process. Also, it is not possible to downgrade the WDM firmware.

**CAUTION**

- Upgrading the WDM firmware makes the WDM offline for some time. During this operation, all the devices drop and join the network again.
- Once initiated, you cannot abort the firmware upgrade operation.
- The WDM must not be turned off while the upgrade is in progress.

The steps for upgrading the WDM from R202 to R210, from R210 to R220 and then from R220 to R230, R230 to R240 are common.

**Prerequisites**

Ensure that the speed/duplex setting for the network adapter of the computer is set to Auto.

**To upgrade the WDM firmware**

1. On the Selection Panel, select the WDM.
2. On the ribbon bar, in the Upgrade group, click **Application**.
   The **WDM Update** dialog box appears.

3. Click **Browse** to navigate to the directory location of the firmware file and click **Open**. The WDM firmware file has a `.tar.gz` extension.
   The **WDM Update** dialog box displays the upload status. Once complete, the **Firmware File** box displays the uploaded firmware file.
4. Click **Update**.
   The firmware upgrade starts and once complete, the user interface displays a message indicating the result of firmware upgrade operation.
Attention

At times, the update may take longer than expected and the result of the upgrade may not be displayed. Instead, a “Page not available” error may appear. In such cases, wait for a minute and then redirect the browser to “https://<ipaddress>/restartzfs.html” for viewing the result. Do not remove or reboot the WDM during the upgrade process.

After the WDM upgrade from R210.1 to R240.1 is complete, the WDM reboots automatically.

5 Close and restart the web browser.
6 Log on to the user interface again.
7 Verify the upgraded version of the WDM firmware as follows:
   1. On the Selection Panel, select the WDM.
   2. On the Property Panel, expand Device Manager Summary.
   3. Under Identification, verify the Revision.

After you have upgraded to the WDM to OneWireless R240, install the WDM license. For detailed instructions on installing the WDM license, refer to "Installing the WDM license" on Page 24.
5.5. Upgrading the field device firmware

The devices at the farthest hop level must be upgraded first.

To upgrade the field device firmware

1. On the Selection Panel of the OneWireless user interface, select the field device.
   
   You can select multiple devices of the same type using the Selection Panel or the map view. Use SHIFT +click to select multiple items in a successive list. Use CTRL+click to select multiple items not in succession.

   ![Attention]
   
   It is recommended that you select and accept only three devices at a time.

2. On the ribbon bar, in the Upgrade group, click one of the following icons, as required.
   
   ![Attention]
   
   Application firmware must be upgraded before upgrading the radio firmware.

   - **Application**: To upgrade the application firmware of the selected field device.
     
     ![Attention]
     
     To initiate the firmware upgrade of the HCI-1WL (CAN-1WL) board using the Application firmware, the SD card must be inserted in the HCI-1WL (CAN-1WL) board. Also, the SD card should not be write protected.

   - **Radio**: To upgrade the radio firmware of the selected field device.
   
   The **Radio/Application Firmware Upgrade** dialog box appears.

3. Depending on the firmware type, the available upgrade files appear by default. Select the required file from the list of upgrade files.
   
   If the file is not available in the list, perform the following steps.
   
   a. Click **Add** to browse to the directory location of the firmware upgrade file.
   b. Click **Open**.

4. Click **Upgrade**.
   
   The **Radio/Application Firmware Upgrade** dialog box closes.

   The **Firmware Upgrade Status** dialog box displaying the status of the upgrade appears.

   ![Firmware Upgrade Status]

   Closing the dialog box allows the upgrade operation to run in the background. The upgrade status is displayed in the status bar. Click the firmware upgrade status box to open the dialog box again. If multiple users are simultaneously upgrading different device firmware, all the users can view the progress of all the device upgrades.
While upgrading the application firmware of a field device, the LCD display of the field device displays the firmware upgrade status. The status is displayed until the upgrade operation completes or aborts.

Once the upgrade is complete, the status column displays the status as complete. If firmware upgrade fails for a device, you can abort the upgrade and start again. To abort firmware upgrade for individual devices, click the abort button next to the status indicator.

**Attention**
- To abort any firmware upgrade operation, click the **Abort Upgrade** icon adjacent to the upgrade status.
- To remove the devices for which the firmware upgrade has been completed, click the **Clear Upgrade** icon adjacent to the upgrade status.

5 Close the **Firmware Upgrade Status** dialog box.

6 Verify the upgraded version of the field device firmware as follows:
- On the Selection Panel, select the field device.
- On the Property Panel, expand **Device Manager Summary**.
- Under **Identification**, verify the **Revision**.
5.6. Upgrading the FDAP/access point firmware

Download the latest FDAP/access point firmware files from the Honeywell Process Solutions website. Note that the farthest hop must be upgraded first.

To upgrade the FDAP/access point firmware

1. On the Selection Panel, select the FDAP/access point.
   You can select multiple devices using the Selection Panel or the map view. Use SHIFT+click to select multiple items in a successive list. Use CTRL+click to select multiple items not in succession.

2. On the ribbon bar, in the Upgrade group, click Radio.
   The Radio Firmware Upgrade dialog box appears.

3. In the Available Firmware Files list, select the required firmware upgrade file.
   By default, the firmware upgrade file appears in the list. If the file is not available in the list, perform the following steps to open the firmware file.
   a. Click Add to browse to the directory location of the firmware upgrade file.
   b. Click Open.

4. Click Upgrade.
   The Firmware Upgrade Status dialog box appears. The Progress column displays the progress of the upgrade.

   Attention
   • To abort any firmware upgrade operation, click the Abort Upgrade icon adjacent to the upgrade status.
   • To remove the devices for which the firmware upgrade has been completed, click the Clear Upgrade icon adjacent to the upgrade status.

5. Close the Firmware Upgrade Status dialog box.

6. Verify the upgraded version of the FDAP / Access Point firmware as follows:
   • On the Selection Panel, select the FDAP / Access Point.
   • On the Property Panel, expand Device Manager Summary.
   • Under Identification, verify the Revision.
5.7. Upgrading CISCO WLC firmware

After upgrading the Field device firmware and the FDAP / access point firmware, upgrade the CISCO WLC firmware. For more information on upgrading the CISCO WLC firmware, refer to the *OneWireless Wireless LAN Controller Configuration Guide*. 
6. R220.1 to R240.1 migration

Related topics
Migrating from R220 to R240 checklist on page 63
Verifying the WDM firmware revision on page 64
Configuring Cisco switch port setting on page 65
Upgrading the WDM firmware on page 66
Upgrading the field device firmware on page 68
Upgrading the FDAP/access point firmware on page 70
Upgrading CISCO WLC firmware on page 71
This topic provides a checklist that describes the significant tasks to be performed for migrating from OneWireless R220.1 to the target release. The checklist also serves as a ready reference to review the progress of migration as you move from one phase of your migration to another. The sections following the checklist provide the details about each task in detail.

**Attention**

Sync must be disabled on a redundant WDM to allow WDM upgrade. If WDM upgrade is initiated on a WDM when sync is enabled an error is displayed. You must disable the sync from WDM PP and again re-initiate the WDM upgrade. Primary WDM cannot sync with secondary WDM running a new release, and so it is recommended that secondary WDM is upgraded first. WDMs may be synchronized while field devices, access points are being upgraded.

This section describes only the tasks that you need to perform for migrating from OneWireless R220.1 to R240.1. If you are migrating from releases prior to R202, you must refer to the migration documentation specific to that release.

<table>
<thead>
<tr>
<th>Task</th>
<th>Go to</th>
<th>Done?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Log on to the OneWireless user interface.</td>
<td>Logging on to OneWireless user interface on page 19</td>
</tr>
<tr>
<td>Step 2</td>
<td>Verify the WDM firmware revision.</td>
<td>Verifying the WDM firmware revision on page 64</td>
</tr>
<tr>
<td>Step 3</td>
<td>Upgrade the WDM firmware.</td>
<td>Upgrading the WDM firmware on page 66</td>
</tr>
<tr>
<td>Step 4</td>
<td>Install the WDM license</td>
<td>Installing the WDM license on page 24</td>
</tr>
<tr>
<td>Step 5</td>
<td>Load the DD files for the field devices.</td>
<td>Loading the Device Description file on page 27</td>
</tr>
<tr>
<td>Step 6</td>
<td>Upgrade the sensor firmware of all field devices.</td>
<td>Upgrading the field device firmware on page 68</td>
</tr>
<tr>
<td>Step 7</td>
<td>Upgrade the radio firmware of all field devices.</td>
<td>Upgrading the field device firmware on page 68</td>
</tr>
<tr>
<td>Step 8</td>
<td>Upgrade the radio firmware of all FDAP routers.</td>
<td>Upgrading the FDAP/access point firmware on page 70</td>
</tr>
<tr>
<td>Step 9</td>
<td>Upgrade the radio firmware of all FDAP access points.</td>
<td>Upgrading the FDAP/access point firmware on page 70</td>
</tr>
<tr>
<td>Step 10</td>
<td>Upgrade the sensor radio firmware of all Multinodes.</td>
<td>Upgrading the FDAP/access point firmware on page 70</td>
</tr>
<tr>
<td>Step 11</td>
<td>Upgrade the CISCO WLC Firmware</td>
<td>Upgrading CISCO WLC firmware on page 71</td>
</tr>
<tr>
<td>Step 12</td>
<td>Re-enable the OPC/HART interfaces.</td>
<td>Re-configuring OPC/HART/MODBUS interfaces on page 46</td>
</tr>
<tr>
<td>Step 13</td>
<td>Upgrade the Provisioning Device Application on the Provisioning Device handheld.</td>
<td>See the “Configuring a Provisioning Device handheld” section in the WDM User's Guide.</td>
</tr>
<tr>
<td>Step 14</td>
<td>Verify if the migrated devices have joined the R240 network</td>
<td>Verifying if the migrated devices have joined the OneWireless R240 network on page 43</td>
</tr>
</tbody>
</table>
6.2. Verifying the WDM firmware revision

To verify the WDM firmware revision
1  On the Selection Panel of the OneWireless user interface, select the WDM.
2  On the Property Panel, expand Device Manager Summary.
3  Under Identification group, review the firmware version displayed in the Revision field.
6.3. Configuring Cisco switch port setting

In case you plan to set up a redundant WDM, ensure the following:

1. CISCO switch port, where the WDM is connected, is configured to operate in access mode.
2. Spanning-tree portfast feature is enabled.
3. Speed is set to auto.
4. Port is in full duplex mode.

Replace the sample CISCO switch configuration for WDM port with the following sample port configuration.

• interface FastEthernet 0/1
• description WDM port
• switchport access vlan 2
• switchport mode access
• spanning-tree portfast
• speed auto
• duplex full

For more information on configuring the Cisco switch port settings, refer to the OneWireless Wireless LAN Controller Configuration Guide.
6.4. Upgrading the WDM firmware

Download the latest WDM firmware file from the Honeywell Process Solutions website. Before upgrading to OneWireless R240.1, make sure that you obtain a valid WDM license key. You can obtain the license key as a part of OneWireless ordering process. Also, it is not possible to downgrade the WDM firmware.

![Attention](image)

**Attention**
Sync must be disabled on a redundant WDM to allow WDM upgrade. If WDM upgrade is initiated on a WDM when sync is enabled an error is displayed. You must disabled the sync from WDM PP and again re-initiate the WDM upgrade.

---

**CAUTION**
- Upgrading the WDM firmware makes the WDM offline for some time. During this operation, all the devices drop and join the network again.
- Once initiated, you cannot abort the firmware upgrade operation.
- The WDM must not be turned off while the upgrade is in progress.
---

The steps for upgrading the WDM from R202 to R210, from R210 to R220 and then from R220 to R230, and R230 to R240 are common.

**Prerequisites**
Ensure that the speed/duplex setting for the network adapter of the computer is set to Auto.

**To upgrade the WDM firmware**

1. On the Selection Panel, select the WDM.
2. On the ribbon bar, in the Upgrade group, click Application.
   
   The WDM Update dialog box appears.

3. Click Browse to navigate to the directory location of the firmware file and click Open. The WDM firmware file has a .tar.gz extension.
   
   The WDM Update dialog box displays the upload status. Once complete, the Firmware File box displays the uploaded firmware file.
4 Click Update.
The firmware upgrade starts and once complete, the user interface displays a message indicating the result of firmware upgrade operation.

⚠️ Attention
At times, the update may take longer than expected and the result of the upgrade may not be displayed. Instead, a “Page not available” error may appear. In such cases, wait for a minute and then redirect the browser to “https://<ipaddress>/restartzfs.html” for viewing the result. Do not remove or reboot the WDM during the upgrade process.

After the WDM upgrade from R220.1 to R240.1 is complete, the WDM reboots automatically.

5 Close and restart the web browser.

6 Log on to the user interface again.

7 Verify the upgraded version of the WDM firmware as follows:
   1. On the Selection Panel, select the WDM.
   2. On the Property Panel, expand Device Manager Summary.
   3. Under Identification, verify the Revision.

After you have upgraded to the WDM to OneWireless R240, install the WDM license. For detailed instructions on installing the WDM license, refer to "Installing the WDM license" on Page 24.
6.5. Upgrading the field device firmware

The devices at the farthest hop level must be upgraded first.

**To upgrade the field device firmware**

1. On the Selection Panel of the OneWireless user interface, select the field device.
   
   You can select multiple devices of the same type using the Selection Panel or the map view. Use SHIFT +click to select multiple items in a successive list. Use CTRL+click to select multiple items not in succession.

   **Attention**
   
   It is recommended that you select and accept only three devices at a time.

2. On the ribbon bar, in the Upgrade group, click one of the following icons, as required.

   **Attention**
   
   Application firmware must be upgraded before upgrading the radio firmware.

   - **Application**: To upgrade the application firmware of the selected field device.
     
     **Attention**
     
     To initiate the firmware upgrade of the HCI-1WL (CAN-1WL) board using the Application firmware, the SD card must be inserted in the HCI-1WL (CAN-1WL) board. Also, the SD card should not be write protected.

   - **Radio**: To upgrade the radio firmware of the selected field device.

   The **Radio/Application Firmware Upgrade** dialog box appears.

3. Depending on the firmware type, the available upgrade files appear by default. Select the required file from the list of upgrade files.
   
   If the file is not available in the list, perform the following steps.
   
   a. Click **Add** to browse to the directory location of the firmware upgrade file.
   
   b. Click **Open**.

4. Click **Upgrade**.

   The **Radio/Application Firmware Upgrade** dialog box closes.

   The **Firmware Upgrade Status** dialog box displaying the status of the upgrade appears.

   Closing the dialog box allows the upgrade operation to run in the background. The upgrade status is displayed in the status bar. Click the firmware upgrade status box to open the dialog box again. If multiple users are simultaneously upgrading different device firmware, all the users can view the progress of all the device upgrades.
While upgrading the application firmware of a field device, the LCD display of the field device displays the firmware upgrade status. The status is displayed until the upgrade operation completes or aborts.

Once the upgrade is complete, the status column displays the status as complete. If firmware upgrade fails for a device, you can abort the upgrade and start again. To abort firmware upgrade for individual devices, click the abort button next to the status indicator.

<table>
<thead>
<tr>
<th>Attention</th>
</tr>
</thead>
<tbody>
<tr>
<td>• To abort any firmware upgrade operation, click the <strong>Abort Upgrade</strong> icon adjacent to the upgrade status.</td>
</tr>
<tr>
<td>• To remove the devices for which the firmware upgrade has been completed, click the <strong>Clear Upgrade</strong> icon adjacent to the upgrade status.</td>
</tr>
</tbody>
</table>

5 Close the **Firmware Upgrade Status** dialog box.

6 Verify the upgraded version of the field device firmware as follows:
   • On the Selection Panel, select the field device.
   • On the Property Panel, expand **Device Manager Summary**.
   • Under **Identification**, verify the **Revision**.
6.6. Upgrading the FDAP/access point firmware

Download the latest FDAP/access point firmware files from the Honeywell Process Solutions website. Note that the farthest hop must be upgraded first.

To upgrade the FDAP/access point firmware

1. On the Selection Panel, select the FDAP/access point.
   You can select multiple devices using the Selection Panel or the map view. Use SHIFT+click to select multiple items in a successive list. Use CTRL+click to select multiple items not in succession.

2. On the ribbon bar, in the Upgrade group, click Radio.
   The Radio Firmware Upgrade dialog box appears.

3. In the Available Firmware Files list, select the required firmware upgrade file.
   By default, the firmware upgrade file appears in the list. If the file is not available in the list, perform the following steps to open the firmware file.
   a. Click Add to browse to the directory location of the firmware upgrade file.
   b. Click Open.

4. Click Upgrade.
   The Firmware Upgrade Status dialog box appears. The Progress column displays the progress of the upgrade.

   Attention
   • To abort any firmware upgrade operation, click the Abort Upgrade icon adjacent to the upgrade status.
   • To remove the devices for which the firmware upgrade has been completed, click the Clear Upgrade icon adjacent to the upgrade status.

5. Close the Firmware Upgrade Status dialog box.

6. Verify the upgraded version of the FDAP / Access Point firmware as follows:
   • On the Selection Panel, select the FDAP / Access Point.
   • On the Property Panel, expand Device Manager Summary.
   • Under Identification, verify the Revision.
6.7. Upgrading CISCO WLC firmware

After upgrading the Field device firmware and the FDAP / access point firmware, upgrade the CISCO WLC 
firmware. For more information on upgrading the CISCO WLC firmware, refer to the OneWireless Wireless 
LAN Controller Configuration Guide.
7. R230.1 to R240.1 migration

Related topics
Migrating from R230 to R240 checklist on page 73
Verifying the WDM firmware revision on page 74
Configuring Cisco switch port setting on page 75
Upgrading the WDM firmware on page 76
Upgrading the field device firmware on page 78
Upgrading the FDAP/access point firmware on page 80
Upgrading CISCO WLC firmware on page 81
## 7.1. Migrating from R230 to R240 checklist

This topic provides a checklist that describes the significant tasks to be performed for migrating from OneWireless R230.1 to the target release. The checklist also serves as a ready reference to review the progress of migration as you move from one phase of your migration to another. The sections following the checklist provide the details about each task in detail.

### Attention

Sync must be disabled on a redundant WDM to allow WDM upgrade. If WDM upgrade is initiated on a WDM when sync is enabled an error is displayed. You must disable the sync from WDM PP and again re-initiate the WDM upgrade. Primary WDM cannot sync with secondary WDM running a new release, and so it is recommended that secondary WDM is upgraded first. WDMs may be synchronized while field devices, access points are being upgraded.

This section describes only the tasks that you need to perform for migrating from OneWireless R230.1 to R240.1. If you are migrating from releases prior to R202, you must refer to the migration documentation specific to that release.

<table>
<thead>
<tr>
<th>Task</th>
<th>Go to</th>
<th>Done?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Log on to the OneWireless user interface.</td>
<td>Logging on to OneWireless user interface on page 19</td>
</tr>
<tr>
<td>Step 2</td>
<td>Verify the WDM firmware revision.</td>
<td>Verifying the WDM firmware revision on page 74</td>
</tr>
<tr>
<td>Step 3</td>
<td>Upgrade the WDM firmware.</td>
<td>Upgrading the WDM firmware on page 76</td>
</tr>
<tr>
<td>Step 4</td>
<td>Install the WDM license</td>
<td>Installing the WDM license on page 24</td>
</tr>
<tr>
<td>Step 5</td>
<td>Load the DD files for the field devices.</td>
<td>Loading the Device Description file on page 27</td>
</tr>
<tr>
<td>Step 6</td>
<td>Upgrade the sensor firmware of all field devices.</td>
<td>Upgrading the field device firmware on page 78</td>
</tr>
<tr>
<td>Step 7</td>
<td>Upgrade the radio firmware of all field devices.</td>
<td>Upgrading the field device firmware on page 78</td>
</tr>
<tr>
<td>Step 8</td>
<td>Upgrade the radio firmware of all FDAP routers.</td>
<td>Upgrading the FDAP/access point firmware on page 80</td>
</tr>
<tr>
<td>Step 9</td>
<td>Upgrade the radio firmware of all FDAP access points.</td>
<td>Upgrading the FDAP/access point firmware on page 80</td>
</tr>
<tr>
<td>Step 10</td>
<td>Upgrade the sensor radio firmware of all Multinodes.</td>
<td>Upgrading the FDAP/access point firmware on page 80</td>
</tr>
<tr>
<td>Step 11</td>
<td>Upgrade the CISCO WLC Firmware</td>
<td>Upgrading CISCO WLC firmware on page 81</td>
</tr>
<tr>
<td>Step 12</td>
<td>Re-enable the OPC/HART interfaces.</td>
<td>Re-configuring OPC/HART/MODBUS interfaces on page 46</td>
</tr>
<tr>
<td>Step 13</td>
<td>Upgrade the Provisioning Device Application on the Provisioning Device handheld.</td>
<td>See the “Configuring a Provisioning Device handheld” section in the WDM User’s Guide.</td>
</tr>
<tr>
<td>Step 14</td>
<td>Verify if the migrated devices have joined the R240 network</td>
<td>Verifying if the migrated devices have joined the OneWireless R240 network on page 43</td>
</tr>
</tbody>
</table>
7.2. Verifying the WDM firmware revision

To verify the WDM firmware revision
1. On the Selection Panel of the OneWireless user interface, select the WDM.
2. On the Property Panel, expand Device Manager Summary.
3. Under Identification group, review the firmware version displayed in the Revision field.
7.3. Configuring Cisco switch port setting

In case you plan to set up a redundant WDM, ensure the following:

1. CISCO switch port, where the WDM is connected, is configured to operate in access mode.
2. Spanning-tree portfast feature is enabled.
3. Speed is set to auto.
4. Port is in full duplex mode.

Replace the sample CISCO switch configuration for WDM port with the following sample port configuration.

- interface FastEthernet 0/1
- description WDM port
- switchport access vlan 2
- switchport mode access
- spanning-tree portfast
- speed auto
- duplex full
7.4. Upgrading the WDM firmware

Download the latest WDM firmware file from the Honeywell Process Solutions website.
Before upgrading to OneWireless R240.1, make sure that you obtain a valid WDM license key. You can obtain the license key as a part of OneWireless ordering process. Also, it is not possible to downgrade the WDM firmware.

**Attention**
Sync must be disabled on a redundant WDM to allow WDM upgrade. If WDM upgrade is initiated on a WDM when sync is enabled an error is displayed. You must disabled the sync from WDM PP and again re-initiate the WDM upgrade.

**CAUTION**
- Upgrading the WDM firmware makes the WDM offline for some time. During this operation, all the devices drop and join the network again.
- Once initiated, you cannot abort the firmware upgrade operation.
- The WDM must not be turned off while the upgrade is in progress.

The steps for upgrading the WDM from R202 to R210, from R210 to R220 and then from R220 to R230, and R230 to R240 are common.

**Prerequisites**
Ensure that the speed/duplex setting for the network adapter of the computer is set to Auto.

**To upgrade the WDM firmware**
1. On the Selection Panel, select the WDM.
2. On the ribbon bar, in the **Upgrade** group, click **Application**. The **WDM Update** dialog box appears.
3. Click **Browse** to navigate to the directory location of the firmware file and click **Open**. The WDM firmware file has a .tar.gz extension.
   The **WDM Update** dialog box displays the upload status. Once complete, the **Firmware File** box displays the uploaded firmware file.
4 Click **Update**.

The firmware upgrade starts and once complete, the user interface displays a message indicating the result of the firmware upgrade operation.

---

**Attention**

- At times, the update may take longer than expected and the result of the upgrade may not be displayed. Instead, a “Page not available” error may appear. In such cases, wait for a minute and then redirect the browser to “https://<ipaddress>/restartzfs.html” for viewing the result. Do not remove or reboot the WDM during the upgrade process.

After the WDM upgrade from R220.1 to R240.1 is complete, the WDM reboots automatically.

---

5 Close and restart the web browser.

6 Log on to the user interface again.

7 Verify the upgraded version of the WDM firmware as follows:

   1. On the Selection Panel, select the WDM.
   2. On the Property Panel, expand **Device Manager Summary**.
   3. Under **Identification**, verify the **Revision**.

After you have upgraded to the WDM to OneWireless R240, install the WDM license. For detailed instructions on installing the WDM license, refer to "Installing the WDM license" on Page 24.
7.5. Upgrading the field device firmware

The devices at the farthest hop level must be upgraded first.

To upgrade the field device firmware

1. On the Selection Panel of the OneWireless user interface, select the field device.
   You can select multiple devices of the same type using the Selection Panel or the map view. Use SHIFT +click to select multiple items in a successive list. Use CTRL+click to select multiple items not in succession.

   Attention
   It is recommended that you select and accept only three devices at a time.

2. On the ribbon bar, in the Upgrade group, click one of the following icons, as required.

   Attention
   Application firmware must be upgraded before upgrading the radio firmware.

   • Application: To upgrade the application firmware of the selected field device.

   Attention
   To initiate the firmware upgrade of the HCI-1WL (CAN-1WL) board using the Application firmware, the SD card must be inserted in the HCI-1WL (CAN-1WL) board. Also, the SD card should not be write protected.

   • Radio: To upgrade the radio firmware of the selected field device.

   The Radio/Application Firmware Upgrade dialog box appears.

3. Depending on the firmware type, the available upgrade files appear by default. Select the required file from the list of upgrade files.
   If the file is not available in the list, perform the following steps.
   a. Click Add to browse to the directory location of the firmware upgrade file.
   b. Click Open.

4. Click Upgrade.

   The Radio/Application Firmware Upgrade dialog box closes.

   The Firmware Upgrade Status dialog box displaying the status of the upgrade appears.

   Closing the dialog box allows the upgrade operation to run in the background. The upgrade status is displayed in the status bar. Click the firmware upgrade status box to open the dialog box again. If multiple users are simultaneously upgrading different device firmware, all the users can view the progress of all the device upgrades.
While upgrading the application firmware of a field device, the LCD display of the field device displays the firmware upgrade status. The status is displayed until the upgrade operation completes or aborts.

Once the upgrade is complete, the status column displays the status as complete. If firmware upgrade fails for a device, you can abort the upgrade and start again. To abort firmware upgrade for individual devices, click the abort button next to the status indicator.

⚠️ Attention

- To abort any firmware upgrade operation, click the Abort Upgrade icon adjacent to the upgrade status.
- To remove the devices for which the firmware upgrade has been completed, click the Clear Upgrade icon adjacent to the upgrade status.

5 Close the Firmware Upgrade Status dialog box.

6 Verify the upgraded version of the field device firmware as follows:

- On the Selection Panel, select the field device.
- On the Property Panel, expand Device Manager Summary.
- Under Identification, verify the Revision.
7.6. Upgrading the FDAP/access point firmware

Download the latest FDAP/access point firmware files from the Honeywell Process Solutions website. Note that the farthest hop must be upgraded first.

To upgrade the FDAP/access point firmware

1. On the Selection Panel, select the FDAP/access point.
   You can select multiple devices using the Selection Panel or the map view. Use SHIFT+click to select multiple items in a successive list. Use CTRL+click to select multiple items not in succession.

2. On the ribbon bar, in the Upgrade group, click Radio.
   The Radio Firmware Upgrade dialog box appears.

3. In the Available Firmware Files list, select the required firmware upgrade file.
   By default, the firmware upgrade file appears in the list. If the file is not available in the list, perform the following steps to open the firmware file.
   a. Click Add to browse to the directory location of the firmware upgrade file.
   b. Click Open.

4. Click Upgrade.
   The Firmware Upgrade Status dialog box appears. The Progress column displays the progress of the upgrade.

   Attention
   • To abort any firmware upgrade operation, click the Abort Upgrade icon adjacent to the upgrade status.
   • To remove the devices for which the firmware upgrade has been completed, click the Clear Upgrade icon adjacent to the upgrade status.

5. Close the Firmware Upgrade Status dialog box.

6. Verify the upgraded version of the FDAP / Access Point firmware as follows:
   • On the Selection Panel, select the FDAP / Access Point.
   • On the Property Panel, expand Device Manager Summary.
   • Under Identification, verify the Revision.
7.7. Upgrading CISCO WLC firmware

After upgrading the Field device firmware and the FDAP/access point firmware, upgrade the CISCO WLC firmware. For more information on upgrading the CISCO WLC firmware, refer to the *OneWireless Wireless LAN Controller Configuration Guide*. 
8. **Migration of OneWireless Network integrated with Experion system**

**Related topics**
- Supported migration paths on page 83
- Planning for migration on page 84
- Post Migration tasks on page 85
8.1. Supported migration paths

The following are the supported migration paths for OneWireless integrated with Experion systems.

- Experion R311.x/OneWireless R120.1 to Experion R410.1/Experion R410.2
- Experion R400.x/OneWireless R120.1 to Experion R410.1/Experion R410.2

For more information on compatibility mapping between Experion and OneWireless releases, refer to Supported migration paths for OneWireless integrated with Experion systems, available on the Honeywell Process Solutions website (http://www.honeywellprocess.com).

In Experion R311.x and R400.x, OneWireless product functionality is integrated into the Experion system. This document describes the tasks that you need to perform to migrate the OneWireless devices integrated with Experion R311.x and R400.x to Experion R410.x which can then be integrated with stand-alone OneWireless Network.

The post migration tasks described in this document are required to be followed if you are upgrading an older version of Experion to Experion R410.x. If you are upgrading from Experion R410.x and above, you can ignore the post-migration steps.
Planning for migration

Following are some of the planning considerations that you must review and address prior to starting the migration.

Planning considerations for Experion

• Complete the preliminary tasks and premigration checks to ensure that the Experion system is ready for migration. For more information about the Experion premigration tasks, refer to the Experion migration documentation.

Planning considerations for OneWireless Network

• Ensure that you have the KeyServerExport Tool available on your system. You can download the KeyServerExport Tool from http://www.honeywellprocess.com/ website.

• Analyze the impact of disconnecting the OneWireless R120 mesh and loss of communication with the wireless field devices.

• Determine the number of WDMs to be configured with the Experion system.

• Download and save the ISA100 Wireless DD files for the XYR 6000 field devices from the Honeywell Process Solutions website.

• OneWireless Network ID 1 is supported in R120.1 but is not supported in R230.1. Migration from R120.1 with Network ID 1 automatically resets multinodes and field devices to defaults. This allows the use of Over The Air Provisioning for re-establishing security without having to physically re-key devices.

When migrating from OneWireless R120 with a Network ID 1, all the devices must be re-provisioned before the migration. The following steps are optional and must be performed only when you face such scenario.

- If the device sensor firmware and the radio firmware are already migrated from R120 to R230, then perform the following:
  1. Configure the R240 system using the First time Configuration Wizard as a new system.
  2. Reset the system to defaults.
  3. Provision all the devices in the ISA100 Wireless network using over-the-air provisioning method. For further information about over-the-air provisioning method, refer to the latest Wireless Device Manager User’s Guide.

- If the device sensor firmware and the radio firmware are still loaded with R120 versions, initialize the Key Server database using Database Manager (dbman), select a network ID between 2 and 65535, and then provision all the devices in the network before starting the migration. For more information refer to the R120 set of documents.
8.3. Post Migration tasks

The post migration tasks described in this document are required to be followed if you are upgrading an older version of Experion to Experion R410.x. If you are upgrading from Experion R410.x and above, you can ignore the following steps.

8.3.1. Configuring OneWireless Components using Control Builder

This section describes the high-level tasks that you must perform to configure the OneWireless Network components using Control Builder.

<table>
<thead>
<tr>
<th>Task</th>
<th>Go to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure WDM.</td>
<td>“Configure a non-redundant WDM” or “Configure a redundant WDM” section in the OneWireless Experion PKS Integration User’s Guide</td>
</tr>
<tr>
<td>After completing the Experion migration, you must create redundant/</td>
<td></td>
</tr>
<tr>
<td>non-redundant WDM blocks using Control Builder.</td>
<td></td>
</tr>
<tr>
<td>Download and import the DD files for the field device.</td>
<td>“Import DD files” section in the OneWireless Experion PKS Integration User’s Guide</td>
</tr>
<tr>
<td>Create field device instances using the DD files.</td>
<td>“Configure field device instances” section in the OneWireless Experion PKS Integration User’s Guide</td>
</tr>
<tr>
<td><strong>Attention</strong></td>
<td></td>
</tr>
<tr>
<td>To preserve previously configured CM/SCM/RCM references to wireless</td>
<td></td>
</tr>
<tr>
<td>data, the wireless device blocks should be assigned the tag names</td>
<td></td>
</tr>
<tr>
<td>and block names that were assigned to the devices configured in the</td>
<td></td>
</tr>
<tr>
<td>previous Experion release.</td>
<td></td>
</tr>
<tr>
<td>Import control strategies with connections to wireless field devices.</td>
<td>“Importing control strategies with connections to wireless field devices” on page 61</td>
</tr>
<tr>
<td>Load the WDM block.</td>
<td>“Loading OneWireless components” section in the OneWireless Experion PKS Integration User’s Guide</td>
</tr>
<tr>
<td>Load the WDM block from the <strong>Project</strong> view to the <strong>Monitoring</strong></td>
<td></td>
</tr>
<tr>
<td>view to view the field devices that have joined the OneWireless</td>
<td></td>
</tr>
<tr>
<td>Network.</td>
<td></td>
</tr>
<tr>
<td>Match devices in the <strong>Project</strong> view to the uncommissioned devices</td>
<td>“Commissioning a device” section in the OneWireless Experion PKS Integration User’s Guide</td>
</tr>
<tr>
<td>in the <strong>Monitoring</strong> view.</td>
<td></td>
</tr>
<tr>
<td>Using Control Builder, view uncommissioned devices for the WDM and</td>
<td></td>
</tr>
<tr>
<td>its associated devices, match the offline configurations to the</td>
<td></td>
</tr>
<tr>
<td>uncommissioned devices in the <strong>Monitoring</strong> view.</td>
<td></td>
</tr>
<tr>
<td>Load wireless device blocks.</td>
<td>“Loading OneWireless components” section in the OneWireless Experion PKS Integration User’s Guide</td>
</tr>
<tr>
<td>Load strategies with connections to wireless data.</td>
<td>“Loading imported strategies with connections to wireless data” on page 63</td>
</tr>
<tr>
<td>Using the OneWireless user interface, upgrade the field device</td>
<td>“Upgrade the field device firmware” section in the Wireless Device Manager User’s Guide</td>
</tr>
<tr>
<td>sensor firmware to the latest OneWireless release firmware.</td>
<td></td>
</tr>
<tr>
<td>The OneWireless R230 base firmware installed during migration may</td>
<td></td>
</tr>
<tr>
<td>not be the released firmware and must be updated. The latest field</td>
<td></td>
</tr>
<tr>
<td>device sensor firmware files can be downloaded from Honeywell</td>
<td></td>
</tr>
<tr>
<td>Process Solutions web site.</td>
<td></td>
</tr>
</tbody>
</table>
8.3.2. Importing control strategies with connections to wireless field devices

Perform the following steps to import the control strategies that you have exported prior to the migration.

**To import control strategies with connections to wireless field devices**

1. From Control Builder, choose **File > Import**.
   
   The **Import** dialog box appears.

2. Click **Browse** and browse to the directory that contains the objects to be imported.

   The directory **C:\Program Data\Honeywell\Experion PKS\IMPORT** is selected by default. If you have selected a different location for storing the exported files, you need to browse to that specific location.

3. In the **Available Objects For Import** list, click **Select All** to import all the available objects.

   - To import only specific objects from the **Available Objects For Import** list, perform the following steps.
     
     1. Press **CTRL/SHIFT** and click the objects.
     2. Click **Select**.

     The selected objects appear in the **Selected Objects For Import** list.

   - If you want to remove all the objects from the **Selected Objects For Import** list, click **Remove All**.

   - If you want to remove specific objects from the **Selected Objects For Import** list, perform the following steps.
     
     1. Press **CTRL/SHIFT** and click the objects.
2. Click Remove.
   The selected objects appear in the Available Objects For Import list.

4 To view the description of the objects in the Selected Objects for Import list and Available Objects for Import list, select the Show Description check box.

5 If you want to rename the objects already existing in the system while importing, select the Enable Objects Rename check box.

6 To view the connections from and the connections to the object that is selected for import, Click View Connection Details.

7 Click Import.
   The Importing Data dialog box appears. The Status column displays the status of each point. The New Name column displays the name of the renamed objects while importing.

   After the import is complete, the Importing Data dialog box closes automatically, if there are no errors. If any errors are encountered during import, the Importing Data dialog box persists until you click Close to quit the Importing Data dialog box.

⚠️ Attention
- Ensure that all the strategies are assigned to their corresponding CEEs. If not, you must manually assign the strategies to the corresponding CEEs.
8.3.3. Loading imported strategies with connections to wireless data

To load the imported strategies

1. In the Project view of Control Builder, select all the strategies that you have imported as described in the section “Importing control strategies with connections to wireless field devices” on page 61.

2. Right-click the strategies, and then click Load.
   The Load Dialog dialog box appears.

3. Verify the following and click OK.
   • Ensure that the Load check box is selected for the CMs or SCMs to be loaded.
   • Ensure that the appropriate automatic change selection check boxes are selected.
   The load operation starts and the Load dialog box displays the progress of the load operation.

   Attention
   • Any errors if detected are displayed in the Load dialog box. System prompts you to continue or cancel the load operation, depending on the nature of the error. It is suggested that you cancel the load, resolve the errors, and then continue.

4. In the Monitoring view, activate the strategies as required.
9. Notices

Other trademarks
Microsoft and SQL Server are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.

Trademarks that appear in this document are used only to the benefit of the trademark owner, with no intention of trademark infringement.

Third-party licenses
This product may contain or be derived from materials, including software, of third parties. The third party materials may be subject to licenses, notices, restrictions and obligations imposed by the licensor. The licenses, notices, restrictions and obligations, if any, may be found in the materials accompanying the product, in the documents or files accompanying such third party materials, in a file named third_party_licenses on the media containing the product, or at http://www.honeywell.com/ps/thirdpartylicenses.
9.1. Documentation feedback

You can find the most up-to-date documents on the Honeywell Process Solutions support website at:

http://www.honeywellprocess.com/support

If you have comments about Honeywell Process Solutions documentation, send your feedback to:

hpsdocs@honeywell.com

Use this email address to provide feedback, or to report errors and omissions in the documentation. For immediate help with a technical problem, contact your local Honeywell Technical Assistance Center (TAC) listed in the “Support and other contacts” section of this document.
9.2. How to report a security vulnerability

For the purpose of submission, a security vulnerability is defined as a software defect or weakness that can be exploited to reduce the operational or security capabilities of the software.

Honeywell investigates all reports of security vulnerabilities affecting Honeywell products and services. To report a potential security vulnerability against any Honeywell product, please follow the instructions at: https://honeywell.com/pages/vulnerabilityreporting.aspx

Submit the requested information to Honeywell using one of the following methods:

• Send an email to security@honeywell.com.
  
or
  
• Contact your local Honeywell Technical Assistance Center (TAC) listed in the “Support and other contacts” section of this document.